
Dual Rail LCD KVM Switch
KL9108 / KL9116

User Manual

www.aten.com



KL9108 / KL9116 User Manual
FCC, CE Information

FEDERAL COMMUNICATIONS COMMISSION INTERFERENCE 
STATEMENT: This equipment has been tested and found to comply with the 
limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These 
limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment. 
This equipment generates, uses, and can radiate radio frequency energy and, if 
not installed and used in accordance with the instruction manual, may cause 
harmful interference to radio communications. Operation of this equipment in 
a residential area is likely to cause harmful interference in which case the user 
will be required to correct the interference at his own expense.

FCC Caution: Any changes or modifications not expressly approved by the 
party responsible for compliance could void the user's authority to operate this 
equipment.

CE Warning: This is a class A product. In a domestic environment this product 
may cause radio interference in which case the user may be required to take 
adequate measures.

RoHS

This product is RoHS compliant.

SJ/T 11364-2006

The following contains information that relates to China.
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User Information

Online Registration
Be sure to register your product at our online support center:

Telephone Support
For telephone support, call this number:

User Notice
All information, documentation, and specifications contained in this manual 
are subject to change without prior notification by the manufacturer. The 
manufacturer makes no representations or warranties, either expressed or 
implied, with respect to the contents hereof and specifically disclaims any 
warranties as to merchantability or fitness for any particular purpose. Any of 
the manufacturer's software described in this manual is sold or licensed as is. 
Should the programs prove defective following their purchase, the buyer (and 
not the manufacturer, its distributor, or its dealer), assumes the entire cost of all 
necessary servicing, repair and any incidental or consequential damages 
resulting from any defect in the software.

The manufacturer of this system is not responsible for any radio and/or TV 
interference caused by unauthorized modifications to this device. It is the 
responsibility of the user to correct such interference.

The manufacturer is not responsible for any damage incurred in the operation 
of this system if the correct operational voltage setting was not selected prior 
to operation. PLEASE VERIFY THAT THE VOLTAGE SETTING IS 
CORRECT BEFORE USE.

International http://eservice.aten.com

International 886-2-8692-6959

China 86-10-5255-0110

Japan 81-3-5615-5811

Korea 82-2-467-6789

North America 1-888-999-ATEN ext 4988

United Kingdom 44-8-4481-58923
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Package Contents

Basic Package
The basic KL9108 / KL9116 package consists of:

1 KL9108 or KL9116 Dual Rail LCD KVM Switch with Standard Rack
Mount Kit

2 Custom KVM Cable Sets

1 Power Cord

1 User Instructions*

1 Quick Start Guide

Optional Equipment
Depending on any optional equipment that you may have purchased, one of the 
following may be included in your package:

Standard Rack Mounting Kit - Long
Easy-Installation Rack Mounting Kit - Short
Easy-Installation Rack Mounting Kit - Long

Check to make sure that all of the components are present and in good order. 
If anything is missing, or was damaged in shipping, contact your dealer.

Read this manual thoroughly and follow the installation and operation 
procedures carefully to prevent any damage to the switch or to any other 
devices on the KL9108 / KL9116 installation.

* Changes may have been made to the manual since it was published. Please 
visit our Website to check for the most up-to-date version.

Copyright © 2014 ATEN® International Co., Ltd.
Manual Part No. PAPE-0267-3AXG

Manual Date: 2014-10-01

Altusen and the Altusen logo are registered trademarks of ATEN International Co., Ltd. All rights reserved.
All other brand names and trademarks are the registered property of their respective owners.
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About This Manual

This User Manual is provided to help you get the most from your KL9108 / 
KL9116 system. An overview of the information found in the manual is 
provided below.

Overview
Chapter 1, Introduction, introduces you to the KL9108 / KL9116 System. 
Its purpose, features and benefits are presented, and its front and back panel 
components are described.

Chapter 2, Hardware Setup, provides step-by-step instructions for setting 
up your installation, and explains some basic operating procedures.

Chapter 3, Basic Operation, explains the fundamental concepts involved 
in operating the KL9108 / KL9116.

Chapter 4, Administration, explains the administrative procedures that are 
employed to configure the KL9108 / KL9116’s working environment, as well 
as how to operate the KL9108 / KL9116 from the local console.

Chapter 5, Browser Operation, describes how to log into the KL9108 / 
KL9116 with your browser, and explains the functions of the icons and buttons 
on the KL9108 / KL9116 web page.

Chapter 6, Windows Client Port Operation, explains how to use the 
Windows Client to access and control the computers connected to the switch.

Chapter 7, Java Client Port Operation, describes how to use the Java 
Client to access and control the computers connected to the switch.

Chapter 8, The Log File, shows how to use the log file utility to view all the 
events that take place on the KL9108 / KL9116.

Chapter 9, The Log Server, explains how to install and configure the Log 
Server.

Chapter 10, AP Operation, describes how to operate the KL9108 / 
KL9116 using Windows and Java Client application programs, rather than with 
the browser method.

Chapter 11, LDAP Server Configuration, explains how to configure the 
KL9108 / KL9116 for LDAP / LDAPS authentication and authorization with 
Active Directory or OpenLDAP.

An Appendix at the end of the manual provides technical and 
troubleshooting information.
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Conventions
This manual uses the following conventions:

Product Information

For information about all ATEN products and how they can help you connect 
without limits, visit ATEN on the Web or contact an ATEN Authorized 
Reseller. Visit ATEN on the Web for a list of locations and telephone numbers:

Monospaced Indicates text that you should key in.

[ ] Indicates keys you should press. For example, [Enter] means 
to press the Enter key. If keys need to be chorded, they 
appear together in the same bracket with a plus sign 
between them: [Ctrl+Alt].

1. Numbered lists represent procedures with sequential steps.

♦ Bullet lists provide information, but do not involve sequential 
steps.

→ Indicates selecting the option (on a menu or dialog box, for 
example), that comes next. For example, Start → Run 
means to open the Start menu, and then select Run.

Indicates critical information.

International http://www.aten.com

North America http://www.aten-usa.com
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Chapter 1
Introduction

Overview

The KL9108 and KL9116 Dual Rail LCD KVM Switches are control units that 
allow secure access to multiple computers from a single KVM (keyboard, 
video, and mouse), console. A single KL9108 or KL9116 can control up to 8 
or 16 computers, respectively. They consist of an integrated LCD monitor, 
keyboard, and touchpad in a in a 1U rack-mountable retractable sliding 
housing. 

The LCD and keyboard/touchpad modules slide independently of each other. 
To maximize space in your data center, the keyboard/touchpad module slides 
back to "hide away" when not in use, while the thin profile LCD monitor 
rotates back – flush against the rack – allowing convenient monitoring of 
computer activity.

The KL9108 / KL9116 features IP-based connectivity that allows one local 
operator and multiple remote operators to concurrently monitor and access the 
computers on your installation. Because the it uses TCP/IP for its 
communications protocol, the KL9108 / KL9116 can be accessed from any 
computer on the LAN, WAN, or Internet – whether that computer is located 
down the hall, down the street, or halfway around the world.

Local

Remote
1
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For added convenience, ports for an external keyboard, monitor, and mouse are 
provided on the rear panel – permitting you to manage the switch from a local 
console up to 20 meters away. There is also an external PS/2 mouse port on the 
keyboard module, allowing you to use an external mouse, rather than the 
touchpad.

Access to any computer connected to the installation from the local console is 
easily accomplished by means of a powerful mouse driven graphical OSD (On 
Screen Display) menu system. A convenient Auto Scan feature also permits 
automatic scanning and monitoring of the activities of all computers running 
on the installation one by one.

Remote operators connect to the KL9108 / KL9116 via its IP address from 
anywhere on the LAN, WAN, or Internet via their browsers. Once they 
successfully log in, they can take control using either the Windows Client or 
Java Client utility. Inclusion of a Java-based client ensures that the KL9108 / 
KL9116 is platform independent, and is able to work with most operating 
systems.

System administrators can handle a multitude of maintenance tasks smoothly 
and efficiently – from installing and running GUI applications, to BIOS level 
troubleshooting, routine monitoring, concurrent maintenance, system 
administration, rebooting and even pre-booting functions – all from a remote 
connection.

Remote operators can exchange keyboard, video and mouse signals with the 
computers attached to the KL9108 / KL9116 just as if they were present locally 
and working on the equipment directly.

Enhanced features include a Panel Array Mode that displays the video output 
of up to 8 (KL9108) or 16 (KL9116) computers at the same time, and a 
Message Board that allows logged in users to conveniently and instantly 
communicate with one other – no matter where in the world they actually are.

The KL9108 / KL9116 utilizes high density 15-pin KVM port connectors 
instead of the usual 25-pin connectors. This space-saving innovation allows a 
full 8 / 16 port switch to be conveniently installed in one unit of system rack 
space.

Setup is fast and easy - plugging cables into their appropriate ports is all that is 
entailed. Because the KL9108 / KL9116 intercepts keyboard input directly, 
there is no need to get involved in complex installation routines or to be 
concerned with incompatibility problems.
2



 Chapter 1. Introduction
Since the KL9108 / KL9116's firmware is upgradable over the Internet, you 
can stay current with the latest functionality improvements simply by 
downloading firmware updates from our website as they become available.

With its advanced security features, the KL9108 / KL9116 is the fastest, most 
reliable, most cost effective way to remotely access and manage widely 
distributed multiple computer installations.

Features

8 (KL9108) / 16 (KL9116) port remote access KVM switch in a sliding 
dual rail housing with top and bottom clearance for smooth operation in a 
1U high rack
Integrated KVM console with 17" LCD monitor, keyboard, and touchpad
Dual slide – LCD Monitor module can slide independently of the 
keyboard/touchpad module
Dual bus support – one local and one remote user can simultaneously 
control up to 8 (KL9108) or 16 (KL9116) computers
A single console controls up to 8 (KL9108) or 16 (KL9116) computers – 
cascade additional units to control up to 128 computers
Remotely access computers via the LAN, WAN, or Internet – control your 
installation when and where you want
Grayscale option to improve transfer speed in low bandwidth situations
User-selectable network transfer rate
External console ports – manage computers in the LCD KVM switch from 
an external console (PS/2 keyboard, monitor, and PS/2 mouse)
Supports external PS/2 mouse
Supports dedicated OSD and OSD Toolbar invocation keys
Console lock – enables the console modules to remain securely locked 
away in position when not in use
Internet browser access – Windows Client and Java Client provided, Java 
Client works with most operating systems*
Graphical OSD and graphical toolbars for convenient, user-friendly 
operation
Up to 64 user accounts – up to 32 concurrent remote logins
Panel Array Mode – view all 8 (KL9108) or 16 (KL9116) ports at the same 
time
3
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Message board feature allows logged in users to communicate with each 
other and allows a remote user to take exclusive control of the KVM 
functions
Windows-based Log Server
Remote power control for attached Power over the Net™ devices
Three user account types: Administrator, User, and Select
Advanced security features include password protection and advanced 
encryption technologies: 1024-bit RSA, 256-bit AES, 56-bit DES, and 
128-bit SSL
Supports RADIUS server authentication
Supports CC1000 management
Flash firmware upgradable over a network connection
Ports can be set to Exclusive, Occupy and Share
Network Interfaces: TCP/IP, HTTP, HTTPS, UDP, RADIUS, DHCP, SSL, 
ARP, DNS, 10Base-T/100Base-TX, Auto Sense, and Ping
High video resolution: up to 1280 x 1024 @ 75Hz (17" LCD monitor); 
1600 x 1200 @ 60Hz (remote computer)
Keyboard Language support: English (US); English (UK); German; 
German (Swiss); French; Spanish; Traditional Chinese; Japanese; Korean; 
Swedish; Italian; Russian; Hungarian and Greek

* Browsers must support 128-bit SSL encryption.
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Requirements

External Console
A VGA, SVGA, or MultiSync monitor capable of displaying the highest 
resolution provided by any computer in the installation
PS/2 keyboard and mouse

Computers
The following equipment must be installed on each computer:

A VGA, SVGA or MultiSync video graphics card with an HDB-15 port

Note: The integrated LCD monitor’s maximum screen resolution is 1280 
x 1024 @ 75 Hz. If you want to use a higher setting for the screen 
resolutions of the attached computers, see Screen Resolutions 
Higher than 1280 x 1024, page 156.

PS/2 mouse and keyboard ports (6-pin Mini-DIN)

Remote Computers
For best results, computers that remotely access the KL9108 / KL9116 
should have at least a P III 1 GHz processor, with their screen resolution 
set to 1024 x 768.
Users who want to access the KL9108 / KL9116 with the Windows Client 
must have DirectX 7.0 or higher installed.
If you don't already have it, DirectX is available for free download from 
Microsoft's Website: http://www.microsoft.com/downloads.

Users who want to access the KL9108 / KL9116 with the Java Client must 
have Sun's Java 2 (1.4.2 or higher) runtime environment installed. Java is 
available for free download from the Sun Java Website: 
http://java.sun.com.
Browsers must support 128-bit SSL encryption.
For best results, a network transfer speed of at least 128 Kbps is 
recommended.
5
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Cables
Substandard cables may degrade system performance or damage your 
installation. For optimum signal integrity and reliability, we strongly 
recommend that you use ATEN's high-quality, custom cable sets. To purchase 
cable sets contact your dealer. Lengths and part numbers are provided in the 
following table.

* These two are functionally the same – they differ slightly in appearance only.

Converters and Adapters
Adapters and converters are used to connect Mac or Sun computers to the 
KL9108 / KL9116. To purchase adapters and converters contact your dealer. 
The type, model number, and purpose of each provided in the following table:

Length (m) Part Number

1.2 2L-5201P

1.8 2L-5202P
2L-5702P*

3.0 2L-5203P

6.0 2L-5206P

Purpose Type Model Number

Connecting USB port computers PS/2 to USB Adapter UC100KMA

Connecting Sun legacy computers Sun Console Converter CV130A

Connecting Sun USB computers Sun Console Converter CV131A
6
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Operating Systems
Supported operating systems are shown in the table, below:

OS Version

Windows 2000 and higher

Linux RedHat 6.0 and higher

SuSE 8.2 and higher

Mandriva (Mandrake) 9.0 and higher

UNIX AIX 4.3 and higher

FreeBSD 3.51 and higher

Sun Solaris 8 and higher

Novell Netware 5.0 and higher

Mac 8.6 and higher

OS/2 Warp and higher

DOS 6.2 and higher
7
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Components

Front View

No. Component Description

1 Upper Handle Pull to slide the LCD module out; push to slide the module in. 
See Opening the Console, page 21, for details on sliding the 
console in and out.

2 LCD Module See LCD Module, page 10.

3 Keyboard Module See Keyboard Module, page 9.

4 Lower Handle Pull to slide the keyboard module out. See Opening the 
Console, page 21, for more details on sliding the console in 
and out.

5 Power LED Lights (blue) to indicate that the unit is receiving power.

6 Keyboard 
Release Catch

These catches (one on each side) release the keyboard 
module so you can slide it away.

7 LCD Release 
Catch

These catches (one on each side) release the LCD module 
so you can slide it away.

8 Rack Mounting 
Tabs

The rack mounting tabs located at each corner of the unit 
secure the chassis to a system rack. See Standard Rack 
Mounting, page 14, for details.

8

6

7

1

5

4

2

3
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Keyboard Module

(Continues on next page.)

No. Component Description

1 Port LEDs An On Line LED lights to indicate that the device attached 
to its corresponding port is up and running.

A Selected LED lights to indicate that the computer 
attached to its corresponding port has the KVM focus.

2 Keyboard Standard 105-key keyboard

2 Touchpad Standard mouse touchpad

4 Reset Switch Pressing and holding this switch in while powering on the 
unit causes the KL9108 / KL9116 to revert to the original 
factory installed firmware version – allowing you to recover 
from a failed firmware upgrade.

Pressing and holding this switch in for more than three 
seconds performs a system reset.

Note: The switch is recessed and must be pushed with a thin 
object - such as the end of a paper clip or a ballpoint pen.

5 Port Selection 
Switches

The left button (DOWN), shifts the KVM focus down 
through the ports (Port 7 → Port 6, etc.). After Port 1, it 
cycles back to the last port.

The right button (UP), shifts the KVM focus up through the 
ports. After the last port, it cycles to Port 1.

2

3

1

7

9

8

4

65
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(Continued from previous page.)

LCD Module

No. Component Description

6 Connection 
LEDs

The LINK LED flashes when a remote client connects to 
the KVM switch.

The 10/100 Mbps LED lights orange to indicate 10 Mbps 
data transmission speed. It lights green for 100 Mbps.

7 External Mouse 
Port

This PS/2-type mouse port is provided for users who prefer to 
use an external mouse.

5 Lock LEDs The Num Lock, Caps Lock, Scroll Lock LEDs are located 
here.

No. Component Description

1 LCD Display To access the LCD monitor, slide the LCD module out and flip 
up the cover. See Opening the Console, page 21, for details 
on sliding the LCD module out.

2 LCD Controls These buttons control the position and picture settings of the 
LCD display. See LCD OSD Configuration, page 27, for 
details.

3 LCD On/Off 
Button

Push this button to turn the LCD monitor on and off. The 
button lights when the LCD monitor is off to indicate that only 
the monitor is off – not the KVM switch itself.)

2

1

3
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Rear View

* The KL9116 is pictured above. The KL9108 rear panel is the same as that of 
the KL9116, except that it has 8 KVM ports instead of 16.

No. Component Description

1 Power Socket This is a standard 3-pin AC power socket. The power cord 
from an AC source plugs in here.

2 Power Switch This is a standard rocker switch that powers the unit on and 
off.

3 PON Port This connector is provided for a Power over the Net™ (PON) 
unit to plug into. A PON device allows computers attached to 
the KL9108 / KL9116 to be booted remotely over the LAN, 
WAN, or Internet. Contact your dealer for more details.

4 KVM Ports The cables that link to the computers plug in here.
Note: The shape of these 15-pin connectors has been 
specifically modified so that only custom KVM cables 
designed to work with this switch can plug in. (See Cables, 
page 6, for details.) Do NOT attempt to use ordinary 15-pin 
VGA connector cables to link these ports to the computers.

5 External Console 
Ports

For flexibility and convenience, the KL9108 / KL9116 
supports an external KVM console. A custom console cable 
set is provided to attach the external console’s monitor, 
keyboard, and mouse.

6 LAN Port The cable that connects the KL9108 / KL9116 to a LAN, 
WAN, or Internet plugs in here.

41 2 3

65
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Chapter 2
Hardware Setup

Before You Begin

1. Important safety information regarding the placement of this 
device is provided on page 139. Please review it before 
proceeding.

2. Make sure that power to all the devices you will be connecting 
up has been turned off. You must unplug the power cords of any 
computers that have the Keyboard Power On function.

3. Packing material has been inserted to protect the KL9108 / 
KL9116 during shipping. Slide the LCD module out (see 
Opening the Console, page 21), until the packing material is 
visible. Remove the packing material before installing the unit, 
as shown in the diagram below.
13
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Standard Rack Mounting

A standard rack mounting kit is provided with your KL9108 / KL9116. The kit 
enables the switch to be mounted in a rack with a depth of 42–77 cm.

Note: 1. It takes two people to mount the switch: one to hold it in place, the 
other to screw it in.

2. The standard rack mounting kit does not include screws or cage nuts. 
If you need additional screws or cage nuts, contact your rack dealer.

3. Optional mounting kits – including single person Easy Installation 
kits – are available with a separate purchase. See Optional Rack 
Mounting, page 161, for details.

L Brackets

Side Mountng
Brackets
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To rack mount the switch, do the following:

1. While one person positions the switch in the rack and holds it in place, the 
second person loosely screws the front brackets to the rack.

2. While the first person still holds the switch in place, the second person 
slides the L brackets into the switch's side mounting brackets, from the 
rear until the bracket flanges contact the rack, then screws the L brackets 
to the rack.

3. After the L brackets have been secured, tighten the front bracket screws.

Note: Allow at least 5.1 cm on each side for proper ventilation, and at least 
12.7 cm at the back for the power cord and cable clearance.
15
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Single Stage Installation

In a Single Stage installation, there are no additional switches daisy chained 
down from the first unit. To set up a single stage installation, refer to the 
installation diagram on the following page (the numbers in the diagram 
correspond to the numbers of the installation steps) and do the following:

1. (Optional) If you choose to install an external console, plug your 
keyboard, monitor, and mouse into the Console Ports located on the 
KL9108 / KL9116’s rear panel. The ports are color coded and marked with 
an icon to identify themselves.

2. Using a KVM cable set (see Cables, page 6), plug the custom SPHD 
(yellow) connector into any available KVM port on the switch.

3. At the other end of the cable, plug the keyboard, video (blue), and mouse 
connectors into their respective ports on the computer.

4. Plug the cable from the LAN into the LAN port on the KL9108 / KL9116’s 
rear panel.

5. Connect the power cord provided with this package to an AC source and 
the KL9108 / KL9116’s power socket.

Repeat steps 2 – 5 for any other computers you wish to install.

After you are all cabled up, you can power on the switch. After the switch is 
powered on, power on the computers.

Note: Although the KL9116 is pictured in the diagram, the installation process 
is the same for the KL9108.
16
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Single Stage Installation Diagram

5

4

1

2

3
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Two Stage Installation

To expand the number of computers that can be controlled in your KVM 
installation, up to 8 (KL9108), or 16 (KL9116) additional KVM switches can 
be cascaded from the KL9108 / KL9116’s KVM ports. As many as 64 
(KL9108) or 128 (KL9116) computers can be controlled in a complete two 
stage installation.

In a two stage installation, the KL9108 / KL9116 is considered the first stage 
unit; the cascaded switches are considered second stage units.

Note: The KVM switch shown in the installation example is the KH98. 
See Supported KVM Switches, page 165, for a complete list of switches 
that can be cascaded from the KL9108 / KL9116.

To set up a two stage installation, refer to the Two Stage Installation diagram 
on the next page, and do the following:

1. Make sure that power to all the devices you will be connecting up, 
including all preexisting devices on the installation, have been turned off.

2. Use a KVM cable set (see Cables, page 6), to connect any available KVM 
Port on the First Stage unit to the Console ports of the Second Stage unit.

3. Use KVM cable sets (as described in the Cables section of the user manual 
for the cascaded KVM switch) to connect any available KVM port on the 
cascaded KVM switch to the keyboard, video, and mouse ports of the 
computers you are installing.

4. Plug the power cord that came with the cascaded KVM switch into its 
power socket, and then into an AC power source.
(Repeat Steps 2–4 for any additional KVM switches that you wish to 
cascade from the KL9108 / KL9116.)

5. Power on the KL9108 / KL9116.

6. Power on the cascaded KVM switches.

7. Power on the computers.
18



 Chapter 2. Hardware Setup
Two Stage Installation Diagram

KH98

KL9116
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Chapter 3
Basic Operation

Opening the Console

The KL9108 / KL9116's console consists of two modules: an LCD display 
module located under the top cover; and a keyboard/touchpad module below 
the LCD module.

The modules can either slide together, or independently. This allows you to 
have the LCD display available for viewing while the keyboard/touchpad 
module is conveniently out of the way when not in use.

Opening Separately
1. Pull the release catch to release the console, and pull the top panel a few 

centimeters toward you. Once the console has been released, you can let 
go of the catch.

(Continues on next page.)

Release Catch
21
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(Continued from previous page.)

2. Pull the top panel all the way out until it clicks into place.

3. Rotate the top panel all the way back to expose the LCD screen.
22



 Chapter 3. Basic Operation
4. Reach underneath and pull the keyboard module all the way out until it 
clicks into place.

Opening Together
Refer to the diagrams in the Opening Separately section as you do the 
following:

1. Pull the release catch and pull the top and bottom panels out until the 
keyboard module clicks into place.

Note: Once the console has been released, you can let go of the catch.

2. Pull the top panel the rest of the way out until it clicks into place.

3. Rotate the top panel all the way back to expose the LCD screen.

Note: Refer to the warning regarding placing excessive weight on the 
keyboard module on the following page.
23
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 Operating Precautions

RIGHT

Rest your hands and arms lightly on the 
keyboard module as you work.

WRONG!

DO NOT lean your body weight on the 
keyboard module.

DO NOT place heavy objects on the 
keyboard module.

The maximum load bearing capacity of the keyboard module is 
30kg. Failure to heed the information below can result in damage 
to the keyboard module.
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Closing the Console

1. Pull the release catches located on either side of the keyboard toward you 
to release the keyboard module, then slide the module slightly in.

2. Let go of the catches. Using the front handle, push the keyboard module 
all the way in.
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3. Rotate the LCD module all the way down, then pull the rear catches to 
release the LCD module.

4. Using the front handle, push the module all the way in.
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LCD OSD Configuration

The LCD Buttons
The LCD OSD allows you to set up and configure the LCD display. Four 
buttons (see LCD Controls, page 10), are used to perform the configuration, as 
described in the table below:

Button Function

MENU When you have not entered the LCD OSD Menu 
function, pressing this button invokes the Menu 
function and brings up the Main Menu.

When navigating through the menus, this button 
moves you right or up. When making an adjustment, it 
increases the value.

When navigating through the menus, this button 
moves you left or down. When making an adjustment, 
it decreases the value.

EXIT When you have not entered the LCD OSD Menu 
function, pressing this button performs an auto 
adjustment. An auto adjustment automatically 
configures all the settings for the LCD panel to what 
the OSD considers their optimum values to be.

When you have entered the LCD OSD Menu 
function, pressing this button exits the current menu 
and returns you to the previous menu. Use it to 
leave an adjustment menu when you are satisfied 
with the adjustment you have made.

When you are at the Main Menu, pressing this 
button exits the LCD OSD.
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The Adjustment Settings
An explanation of the LCD OSD adjustment settings is given in the table 
below:

Setting Explanation

Brightness Adjusts the background black level of the screen image.

Contrast Adjusts the foreground white level of the screen image.

Phase If pixel jitter or horizontal line noise is visible on the display, your 
LCD may have the wrong phase setting. Adjust the phase setting 
to eliminate these problems.

Clock If vertical banding is visible on the display, your LCD may have 
the wrong clock setting. Adjust the clock setting to eliminate 
vertical banding.

H-Position Positions the display area on the LCD panel horizontally (moves 
the display area left or right).

V-Position Positions the display area on the LCD panel vertically (moves 
the display area up or down).

Color Temperature Adjusts the color quality of the display. You can adjust the 
“warmth” value, color balance, etc. The Adjust Color selection 
has a further submenu that lets you fine tune the RGB values.

Language Selects the language that the OSD displays its menus in.

OSD Duration Lets you set the amount of time that the OSD displays on the 
screen. If there is no input for the amount of time you choose, the 
OSD display turns off.

Reset Resets the menu and submenu adjustments (except for 
language settings) to the original factory default settings.
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Port Selection

The KL9108 / KL9116 provides three port selection methods to access the 
computers on the installation: Manual, an OSD (On Screen Display) menu 
system, and Hotkeys. OSD Operation and Hotkey Port Selection are discussed 
in the Windows Client Port Operation and Java Client Port Operation 
Chapters.

Manual Port Switching
Use the Port Selection Switches on the keyboard to manually switch to a port.

Hot Plugging

The KL9108 / KL9116 supports hot plugging - components can be removed 
and added back into the installation by unplugging and replugging their cables 
from the ports without the need to shut the unit down.

If you change computer positions, in order for the OSD menus to correspond 
to the KVM port changes, you must manually edit the Port Names for the OSD 
to reflect the new port information. See Port Names, page 36, for details.

Note: If the computer's operating system does not support hot plugging, this 
function may not work properly.

Powering Off and Restarting

If it becomes necessary to power off the KL9108 / KL9116, or if the switch 
loses power and needs to be restarted, wait 10 seconds before powering it back 
on. The computers should not be affected by this, but if any of them should fail, 
simply restart the affected computers.

Port ID Numbering

Each of the KL9108 / KL9116’s KVM ports is assigned a two-digit Port ID 
number. You can access any device by specifying the Port ID of the port that 
it is connected to. Port numbers from 1 - 9 are padded with a preceding zero, 
so they become 01 - 09.

For example, a computer attached to Port 6 would have a Port ID of: 06.
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Chapter 4
Administration

Overview

The OSD's Administration page lets the Administrator (and users with 
administration permission - see User Management, page 42) configure and 
control the overall operations of the KL9108 / KL9116. The Administration tab 
is disabled (grayed out) for users who do not have administration permission.

The Local Console

Once the KL9108 / KL9116 has been installed, the next step that the 
Administrator needs to perform is to set up the unit for user operation. The 
most convenient way to do this for the first time is from the local console.

After turning on the KL9108 / KL9116, a login prompt appears:

Since this is the first time you are logging in, use the default Username: 
administrator; and the default Password: password. For security purposes, we 
strongly recommend that you use the User Management function (see page 42) 
to remove these and give yourself a unique Username and Password with the 
appropriate permissions.
31



KL9108 / KL9116 User Manual
After you successfully log in, the Local Console OSD appears:

The OSD consists of four pages, each with a specific set of functions: Main, 
Configuration, Administration, and Log. Each of page is discussed in the 
sections that follow.

The functions of the four buttons at the right of the title bar are described in the 
table below. Functions can be invoked by clicking the icon, or by pressing its 
associated function key.

Button Key Function

F6

Screen View: Depending on the display resolution of the port 
you are viewing, the OSD it may appear smaller than normal. 
Use this function to return the OSD to its original size and 
blank the background. Click again to recover the background.

F7

Transparency: Makes the OSD semi transparent, allowing 
the background to show through. Clicking again, returns the 
OSD to normal.
Note: 1. We recommend setting your monitor refresh rate to 

a value greater than 75Hz before using this feature.
2. If you switch to a null port when Transparency is 

enabled, the feature becomes disabled.

F8
Log Out: Closes the OSD display and logs you out of the 
session.

Esc
Close: Closes the OSD display but does not log you out of 
the session. You can bring the display back with the OSD 
hotkeys (see OSD Hotkey, page 40).
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The Main Page

The Main page governs port access. Selecting a port and double-clicking it 
switches you to the device on that port.

A monitor icon is in front of the port number. The monitor icon is green 
for ports that have devices connected to them that are powered on; 
otherwise, it is gray.
If a port has been specified as a Quick View port (see below), a red eye 
icon is displayed along with the monitor icon to indicate so.

In addition to using this page to select ports to switch to, the administrator can 
also use this page to enable/disable Quick View status for selected ports, and to 
create, modify, or delete names for each of the ports. The following sections 
describe how to enable Quick View status and how to create, modify, or delete 
port names.

Quick View Ports
Selecting certain ports as Quick View ports is a way of limiting which ports are 
included when the KL9108 / KL9116 is in Auto Scan mode. If the KL9108 / 
KL9116 is configured to only auto scan ports that have Quick View status (see 
Scan Select, page 40), designating a port as a Quick View port in this dialog 
box means that it will be included when auto scanning is in effect.

The spacebar toggles a port's Quick View status. To select/deselect a port, 
highlight it and press the spacebar. When a port has been selected as a Quick 
View port, a red eye icon displays in the port icon column to indicate so. When 
a port isn't selected, there is no red eye icon.
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The List Function
The List Function lets you broaden or narrow the scope of which ports the OSD 
displays (lists) in the Main Screen. To invoke the List Function, click the arrow 
at the upper right corner of the screen, or press [F3]:

The screen changes to allow you to choose the ports that will be listed:
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The drop down list on the left offers four fixed choices as shown in the table, 
below:

The text input box on the right allows you to key in a port name so that only 
port names that match what you key in show up in the List. Wildcards (? and 
*) are acceptable, so that more than one port can show up in the list. For 
example, if you key in Web*, both Web Server 1 and Web Server 2 would 
show up in the list, as shown in the screen shot below:

After you key in your string, either click the binoculars to the right of the 
box, or press [Enter].
To go back to the default view, erase the string and either click the 
binoculars to the right of the box, or press [Enter].
To dismiss the List function, click the arrow or press [F3].

Choice Meaning

All Lists all of the ports on the installation.

Powered On Lists only the ports that have their attached devices 
powered on.

Quick View Lists only the ports that have been selected as Quick 
View ports (see Quick View Ports, page 33).

Quick View + Powered On Lists only the ports that have been selected as Quick 
View Ports (see Quick View Ports, page 33), and that 
have their attached devices Powered On.
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Port Names
To help remember which computer is attached to a particular port, every port 
can be given a name. This field allows the Administrator to create, modify, or 
delete port names. To configure a port name:

1. Click once on the port you want to edit, wait one second and then click 
again. (Alternately, use the up and down arrow keys to move the highlight 
bar to the port, and then press the F2 function key.)

 

Note: This is not a double-click. It involves two separate clicks. A double-
click will switch you to the device attached to the port.
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After a second or two, the bar changes to provide you with a text input 
box:

 

2. Key in the new Port Name, or modify/delete the old one.
 

The maximum number of characters allowed for a Port Name is 19. You 
can use all letters, numbers, and symbols on the typewriter keys of 
keyboards with PC US English layout.
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3. When you have finished editing the port name, press [Enter] or click 
anywhere outside of the input box to complete the operation.

Port Operation

Because the methods used to access the target device(s) are the same for the 
local console as for the Windows Client, the procedures are discussed in 
Windows Client Port Operation and Java Client Port Operation Chapters on 

pages 85 and 102, respectively.

Note: If you invoke the OSD while accessing a target device from the local 
console, press [F6] to hide the background and enlarge the OSD. Press 
[F6] again to show the background.
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The Configuration Page

The OSD Configuration page allows users to set up their own, individual, 
working environments. The KL9108 / KL9116 stores a separate configuration 
record for each user profile, and sets up the working configuration according 
to the Username that is used to log in.

 

The Configuration page settings are explained in the table on the following 
page.

(Continues on next page.)
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(Continued from previous page.)

Setting Function

OSD Hotkey Selects which Hotkey controls the OSD function: [Scroll Lock] 
[Scroll Lock] or [Ctrl] [Ctrl]. Since the Ctrl key combination may 
conflict with programs running on the computers, the default is the 
Scroll Lock combination.

ID Display Selects how the Port ID is displayed: the Port Number alone (PORT 
NUMBER); the Port Name alone (PORT NAME); or the Port Number 
plus the Port Name (PORT NUMBER + PORT NAME). The default is 
PORT NUMBER + PORT NAME.

ID Duration Determines how long a Port ID displays on the monitor after a port 
change has taken place. You can choose an amount from 0 - 255 
seconds. The default is 5 Seconds. 0 is Always On.

Scan Select Selects which computers will be accessed under Auto Scan Mode 
(see Auto Scanning, page 90). Choices are: ALL - All the Ports which 
have been set Accessible (see Port Access, page 44); POWERED 
ON - Only those Ports which have been set Accessible and are 
Powered On; QUICK VIEW - Only those Ports which have been set 
Accessible and have been selected as Quick View Ports (see Quick 
View Ports, page 33); QUICK VIEW + POWERED ON - Only those 
Ports which have been set Accessible and have been selected as 
Quick View Ports and are Powered On. The default is ALL.

Scan Duration Determines how long the focus dwells on each port as it cycles 
through the selected ports in Auto Scan Mode (see Auto Scanning, 
page 90). Key in a value from 0 - 255 seconds. The default is 10 
seconds; a setting of 0 disables the Scan function.

Screen Blanker If there is no input from the console for the amount of time set with 
this function, the screen is blanked. Key in a value from 1 - 30 
minutes. A setting of 0 disables this function. The default is 0 
(disabled).

Logout Timeout If there is no Operator input for the amount of time set with this 
function, the Operator is automatically logged out. A login is 
necessary before the KL9108 / KL9116 can be accessed again. Enter 
a value from 0 - 180 minutes. The default is 30 minutes. 0 disables 
the function.

Beeper When set to ON, the beeper sounds whenever the port is switched, 
when activating the Auto Scan function (see Auto Scanning, 
page 90), or when an invalid entry is made on an OSD menu. The 
default is ON.

Change 
Password

Allows a user to change the account password. After clicking the 
Change Password button, a dialog box appears. Enter the old 
password. Then, enter a new password and confirm it by entering it 
again. Press OK to save changes, or press Cancel to discard 
changes.
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The Administration Page

When you click the Administration tab, the Administration page comes up. 
Each of the administrative functions is represented by an icon at the left of the 
page. Clicking the icon brings up its associated dialog box. When the 
Administration page first comes up the General dialog box appears:

 

General
The General Page presents four items of information. This is the same 
information that displays after you log in from a browser, or when you click the 
General icon at the top left of the browser main page. The meaning of these 
items is described in the table below:

Item Description

Device Name This field lets you give the switch a unique name. This can be 
convenient when you need to differentiate among several 
devices in multi-station installations.

MAC Address This item displays the KL9108 / KL9116's MAC address.

Firmware Ver This item displays the current firmware version number. You can 
reference it to see if there are newer versions available on the 
Altusen Website.

Last IP from DHCP 
Server

If the switch is on a network that uses DHCP assigned IP 
addresses, this item is a convenient way of ascertaining what its 
IP address is, to inform the Users which IP to use when they 
want to log in to the KL9108 / KL9116.
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User Management
The User Management dialog box is used to create and manage user profiles. 
Up to 64 user profiles can be established.

 

To delete a user profile, select it in the list box, and Click Remove.
To modify a user profile, select it and Click Edit.
To add a user, Click New.

If you choose Edit or New, a dialog box similar to the one below appears:
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Fill in the required information for a new profile, or modify the existing 
information to edit a previous profile. A description of the field headings is 
given in the table below:

(Continues on next page.)

Heading Description

Username  A minimum of 6 and a maximum of 15 characters is allowed.

Password A minimum of 8 and a maximum of 15 characters is allowed.

Confirm Password To be sure there is no mistake in the password, you are asked to 
enter it again. The two entries must match.

Description Additional information about the user that you may wish to include.

Admin Enabling this gives the user Administrator level access to the 
KL9108 / KL9116. All permissions are granted. (See Permissions, 
in this table.)

User Enabling this gives the user User level access to the KL9108 / 
KL9116. Windows Client, Power Manager, and Java Client 
permissions are granted. (See Permissions, in this table.)

Select This button is automatically enabled if the permission choices 
selected by the Administrator (in the panel just below) do not 
match the default access level choices for Admin or User.

Permissions These are used together with the Select radio button to set up 
permissions that differ from the defaults for Admin and User.
1. Checking Administration gives a User administration privileges, 

which allows him to set up and modify the KL9108 / KL9116's 
Administration page settings.

2. Checking Windows Client allows a user to access the KL9108 / 
KL9116 via the Windows Client software. By default, all users 
may access the KL9108 / KL9116 via the Windows Client 
software.

3. Checking Log allows a User to view and query the log file. The 
Log and Log Server buttons appear on the Main web page of 
Users who have Log permission (see Webpage Buttons, 
page 67).

4. Checking Power Manager allows a User to connect to Power 
on the Net™ devices. The PON button appears on the Main 
web page of Users who have Power Manager permission (see 
Webpage Buttons, page 67).

5. Checking Java client allows a User to access the KL9108 / 
KL9116 via the Java Client software.

6. Checking Force to Grayscale, forces the user’s view of the 
remote display to be in grayscale. This can speed up I/O 
transfer in low bandwidth situations.
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(Continued from previous page.)

 

Heading Description

Port Access This function allows the Administrator or a User with 
Administration permission to define the selected User's 
access to the computers on a Port-by-Port basis. (See the 
screen, below.)
For each User profile, select a port and click it to cycle 
through the choices:
Full - The user can view the screen and can perform 
operations on the system from the keyboard and mouse.
View - A diagonal line through the port icon indicates the 
port access is View. The user can view the screen, but 
cannot perform operations on the system.
Null (no access rights) - An X through the port icon indicates 
no port access. The Port will not show up on the User's list 
on the Main Screen.
Repeat until access rights have been set for all ports.
The default is Full for all users on all Ports.
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Service Configuration

Access Port
As a security measure, if a firewall is being used, the Administrator can specify 
the port numbers that the firewall will allow, and set the firewall accordingly. 
Users must specify the port number when they log in to the KL9108 / KL9116. 
If an invalid port number (or no port number) is specified, the KL9108 / 
KL9116 will not be found.

An explanation of the fields is given in the table below:

Note: 1. If there is no firewall (on an intranet, for example), it doesn't matter 
what these numbers are set to, since they have no effect.

2. You must set different values for each of the service ports.

Field Explanation

Program This is the port number that must be specified when connecting 
from the Windows Client software program. Valid entries are 
from 1024-60,000. The default is 9000.

Java This is the port number used for Java Client connections. Valid 
entries are from 0-65535. The default is 9002.

HTTP The port number for a browser login. The default is 80.

HTTPS The port number for a secure browser login. The default is 443.
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Log Server

Important transactions that occur on the KL9108 / KL9116, such as logins and 
internal status messages, are kept in an automatically generated log file. In this 
panel, you specify the MAC address and a port number for the computer that 
the Log Server resides on.

Installation and operation of the Log Server is discussed in Chapter 9. The Log 
File is discussed in Chapter 8.
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Network 
The Network dialog is used to specify the KL9108 / KL9116's network 
environment.

Network Transfer Rate
Set the rate at which the KL9108 / KL9116 transfers data to remote computers. 
The range is from 8 to 99999 Kilobytes per second (KBps). 

IP Address
The KL9108 / KL9116 can either have its IP address assigned dynamically 
(DHCP), or it can be given a fixed IP address.

For dynamic IP address assignment, select the Obtain IP address 
automatically radio button.
To specify a fixed IP address, select the Set IP address manually radio 
button and fill in the IP address, subnet mask and default gateway.

DNS Server
For automatic DNS Server address assignment, select the Obtain DNS 
Server address automatically, radio button.
To specify the DNS Server address manually, select the Use the following 
DNS Server radio button, and fill in the addresses for the Primary and 
Alternate DNS servers.

Note: Specifying at the primary DNS Server address is mandatory. The 
alternate DNS Server address is optional.
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ANMS
The Advanced Network Management Settings page is used to set up login 
authentication and authorization management from external sources. Click on 
the ANMS icon to select RADIUS, LDAP, or CC Management. 

RADIUS
If you are using a RADIUS server, set up its parameters as follows:

1. Check Enable.

2. Fill in the IP addresses and Service Ports for the Primary and Alternate 
RADIUS servers.

(Continues on next page.)
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(Continued from previous page.)

3. Set the time in seconds that the KL9108 / KL9116 waits for a RADIUS 
server reply before it times out in the Timeout field.

4. Set the number of RADIUS retries allowed in the Retries field.

5. Key the Shared Security character string for authentication between the 
KL9108 / KL9116 and the RADIUS Server in this field.

6. On the RADIUS server, set the access rights for each user according to the 
information in the table on page 50.

Note: 1. The characters are not case sensitive. Capitals or lower case work 
equally well. 

2. Characters are comma delimited.

3. An invalid character in the configuration string will prohibit access to 
the KL9108 / KL9116 for the user.

Examples:

String Meaning

c,w,p User has administrator privileges; user can access the system via the 
WinClient ActiveX Viewer; user can access the attached PN0108.

w,j,l User can access the system via the WinClient ActiveX Viewer; user can 
access the system via the Java Client; user can access log information 
via the user's browser.
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Character Meaning

C Grants the user administrator privileges, allowing the user to 
configure the system.

W Allows the user to access the system via the WinClient ActiveX 
Viewer program.

J Allows the user to access the system via the Java Client program.

P Allows the user to access an attached Power Over the Net™ device.

L Allows the user to access log information via the user's browser.

PN Restricts the user from accessing the OSD port list.
Syntax: pn/1/2/3/4

PV Limits the user's access to viewing of the OSD port list only.
Syntax: pv/1/2/3/4

UHK Defines the OSD Hotkey (see OSD Hotkey, page 40).
(uhk0: Scroll Lock + Scroll Lock; uhk1: Ctrl + Ctrl)
Syntax: uhk0

UOL Defines the OSD List Function (see page 34).
(uol0: All; uol1: Powered On; uol2: Quick View; uol3: Quick View + 
Powered On)
Syntax: uol0

UODM Selects how the Port ID displays (see ID Display, page 40).
(uodm0: Port Number + Port Name; uodm1: Port Number; uodm2: 
Port Name)
Syntax: uodm0

UODT Determines the length of time in seconds that the Port ID displays on 
the monitor after a port change (see ID Duration, page 40).
Syntax: uodtn (where n represents a number from 0-255)

UBUZ Turns the beeper on or off (see Beeper, page 40).
(ubuz0: Beeper Off; ubuz1: Beeper On)
Syntax: ubuz0

ULT When there is no input from the user for the amount of time set with 
this function, the user is automatically logged out. The user will need 
to log in again. Set the Logout Timeout from 0-180 minutes.
Syntax: ultn (where n represents a number from 0-180)

USM Selects which computers are accessed under Auto Scan Mode (see 
Scan Select, page 40).
(usm0: All; usm1: Powered On; usm2: Quick View; usm3: Quick View 
+ Powered On)
Syntax: usm0

UST Determines the length of time in seconds the KVM focus dwells on 
each port in Auto Scan Mode (see Scan Select, page 40).
Syntax: ustn (where n represents a number from 0-255)
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LDAP / LDAPS
To allow authentication and authorization for the KL9108 / KL9116 via LDAP 
/ LDAPS, set the parameters as follows:

1. Check the box to enable LDAP / LDAPS authentication and authorization.

2. Click a radio button to specify whether to use LDAP or LDAPS

3. Fill in the IP address and port number for the LDAP or LDAPS server. For 
LDAP, the default port number is 389; for LDAPS, the default port 
number is 636.

4. Set the time in seconds that the KL9108 / KL9116 waits for an LDAP or 
LDAPS server reply before it times out.

5. Consult the LDAP / LDAPS administrator to ascertain the appropriate 
entry for this field. For example, the entry might look like this:
ou=kn4132,dc=aten,dc=com

6. Key in the LDAP administrator’s username.

7. Key in the LDAP administrator’s password.

8. Set the distinguished name of the search base. This is the domain name 
where the search starts for user names.

Note: If LDAP Settings is enabled, the LDAP schema for MS Active 
Directory must be extended. See LDAP Server Configuration, 
page 123, for details.
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CC Management Settings
To allow authorization for the KL9108 / KL9116 through a CC (Control 
Center) server, check Enable and fill in the CC Server’s IP address and the port 
that it listens on in the appropriate fields.

Note: The current firmware (insert firmware version) supports CC1000 only. 
Future firmware upgrades will provide support for CC2000. Please visit 
our website to download the most up-to-date version of the firmware.
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Security
The Security page controls access to the KL9108 / KL9116.

IP and MAC Filtering
If any filters have been configured, they appear in the IP Filter and/or 
MAC Filter list boxes.
IP and MAC Filters control access to the KL9108 / KL9116 based on the 
IP and/or MAC addresses of the computers attempting to connect. A 
maximum of 100 IP filters and 100 MAC filters are allowed. To enable IP 
and/or MAC filtering, Click to put a check mark in the IP Filter Enable 
and/or MAC Filter Enable checkbox.

If the include button is checked, all the addresses within the filter range 
are allowed access; all other addresses are denied access.
If the exclude button is checked, all the addresses within the filter 
range are denied access; all other addresses are allowed access.

To add a filter, click New. A dialog box similar to the ones below appears:
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Note: Each IP filter can consist of a single address, or a range of addresses. 
To filter a single IP address, key in the same address in both the 
From and To fields. To filter a continuous range of IP addresses, key 
in the start of the range in the From field; key in the end of the range 
in the To field.

After you specify the filter addresses, click OK.

To delete a filter, select it in the IP Filter and/or MAC Filter list boxes and 
click Remove.
To modify a filter, select it in the IP Filter and/or MAC Filter list boxes 
and click Edit. The Edit dialog box is similar to the New dialog box. 
When it comes up, simply delete the old address and replace it with the 
new one.

Default Webpage Name
The Default web page name entry field lets the Administrator specify a 
login string (in addition to the IP address) that the user must include when 
accessing the KL9108 / KL9116 with a browser. For example:

192.168.0.126/abcdefg

The user must include the forward slash and the string along with the IP 
address. For security purposes, we recommend that you change this string 
from time to time.

Note: If no string is specified here, anyone will be able to access the 
KL9108 / KL9116 with the Web browser using the IP address alone. 
This makes your installation less secure.
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Customization 

The Customization dialog box is arranged in four major sections: Login 
Failures; Working Mode; I/O; and untitled miscellaneous functions at the 
bottom. The functions of each of the Customization items are described in the 
sections that follow:

Login Failures
Allowed: sets the number of consecutive failed login attempts that are 
permitted from a remote computer.
Timeout: sets the amount of time a remote computer must wait before 
attempting to login again after it has exceeded the number of allowed 
failures.

Working Mode
If Stealth Mode is enabled, the KL9108 / KL9116 cannot be pinged.
To permit browser access to the KL9108 / KL9116, click to put a check 
mark in the Enable Browser checkbox. If browser access is not enabled, 
users will not be able to log into the unit via their browsers.
If Multiuser Operation is enabled, up to 32 users can simultaneously 
access the KL9108 / KL9116.
If Set default to grayscale is enabled, the remote display is changed to 
grayscale. This can speed up I/O transfer in low bandwidth situations.
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Note: Although enabling this option sets the default to grayscale, users can 
change their sessions to color – unless the administrator enabled the 
Force to Grayscale option, when the user was created (see page 42 
for details).

I/O
Attributes
Clicking the Attributes button brings up a dialog box that allows you to set 
Share mode and Timeout threshold for each of the ports:

To set a port’s Share mode, double click it to bring up the I/O attributes 
dialog box:
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Set the port’s Share mode according to the information in the following 
table:

The Timeout field sets a time threshold for users on ports whose Share 
Mode has been set to Occupy (see Occupy:, page 57). If there is no activity 
from the user occupying the port for the amount of time set here, the user 
is timed out and the port is released. The first user to send keyboard or 
mouse input after the port has been released gets to occupy the port.
Input a value from 0 to 255 seconds. The default is 3 seconds. A setting of 
0 causes the port to be released the instant there is no input.

Attribute Action

Exclusive: The first user to occupy the port has exclusive control over it. 
No other user can view or access it.

Occupy: The first user to occupy the port has control over it. Up to 31 
additional users can view its video output, however. The 
Timeout function discussed on page 57 applies to ports that 
have this setting.

Share: Allows up to 32 users to simultaneously share control over the 
port. User input is placed in a queue and executed on a first 
sequentially. In addition, a user can access the KL9108 / 
KL9116’s Message Board function to gain control of the 
keyboard and mouse, or keyboard, video, and mouse of a 
Share designated port. See The Message Board, page 81.
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Miscellaneous
The functions performed by the remaining elements at the bottom of the screen 
are described in the table below:

Parameter Explanation

Reset on exit Place a check here to have the KL9108 / KL9116 reset itself 
and implement all the new settings when you log out. 
Following the reset, wait one to two minutes before logging 
back in.
Note: For some changes the Reset on exit check box is 
automatically selected and the KVM switch will reset when 
you log out. Clearing the check mark before logging out will 
cause the new settings to be discarded.

Reset Values Clicking this button undoes all changes that have been made 
to the Configuration and Administration pages (except for port 
names, usernames, and passwords) and returns the 
parameters to the original factory default settings (see OSD 
Factory Default Settings, page 148).

Clear Name List This function clears the Port Names on the Main page.
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Date/Time
The Date/Time dialog box lets the Administrator set up the KL9108 / KL9116's 
time parameters:

If your country or region employs Daylight Saving Time (Summer Time), 
check the corresponding box.
To establish the time zone that the KL9108 / KL9116 is located in, drop 
down the Time Zone list and choose the city that most closely corresponds 
to where it is at.
To set the year and day, use the Calendar graphic.

Clicking < or > moves you backward or forward by one month 
increments.
Clicking << or >> moves you backward or forward by one year 
increments.
In the calendar, click on the day.

To set the time, use the 24 hour HH:MM:SS format.
Click Synchronize to save your settings.
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The Log Page

Clicking the Log tab brings up the contents of the log file. The log file is 
discussed in Chapter 8.
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Upgrading the Firmware

As new versions of the KL9108 / KL9116 firmware become available, they can 
be downloaded from our Website.

Note: Although upgrading the firmware isn't on the OSD Administration 
page, it is an administrative function, so we chose to discuss it in this 
chapter.

To upgrade the firmware, do the following:

1. Download the new firmware file to a computer that is not part of your 
KL9108 / KL9116 installation. 

2. From that computer, open your browser and log in to the KL9108 / 
KL9116 (see Logging In, page 63).

3. Click the Firmware icon (see Webpage Icons, page 65) to open the 
Firmware configuration dialog box:

4. Click Browse; navigate to the directory that the new firmware file is in 
and select the file.

5. Click Upgrade.

6. After the upload completes, click the Logout icon to exit and reset the 
KL9108 / KL9116.
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Chapter 5
Browser Operation

Overview

An On Screen Display (OSD) interface governs KL9108 / KL9116 computer 
control and switching operations. The OSD can be accessed remotely with a 
Windows-based client or a Java-based client. You must log in via an Internet 
browser to connect to the KL9108 / KL9116 and to invoke the OSD.

Logging In

To log in from an Internet browser:

1. Open the browser and specify the IP address and Default Webpage name 
(if one has been specified) for the KL9108 / KL9116 in the URL bar.

Note: If you don't know the IP address and Default Webpage name, get it 
from the KL9108 / KL9116 administrator.

2. When the Security Alert dialog box appears, accept the certificate – it can 
be trusted. (See Trusted Certificates, page 149, for details.) A login page 
appears:
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3. Provide a valid Username and Password (set up by the KL9108 / KL9116 
administrator), then Click Login to continue.

Note: 1. If you supply an invalid login, the authentication routine will 
return a message stating, Invalid Username or Password. Please 
try again. If you exceed the number of login failures set by the 
administrator, a message stating that The page cannot be 
displayed, appears. This is done to confuse and discourage 
hackers from trying to discover a valid Username and Password. 
If you see this message, try logging in again being careful with the 
Username and Password.

2. If you are the Administrator and are logging in for the first time, 
use the default Username: administrator; and the default 
Password: password. For security purposes, we strongly 
recommend you remove these and give yourself a unique 
Username and Password (see User Management, page 42).

After you have successfully logged in, the KL9108 / KL9116 Main webpage 
appears with the General dialog box displayed:

Note: This is the same dialog box that appears whenever you click the General 
icon at the top left of the page.
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Webpage Layout

Webpage Icons
The functions of the icons at the top of the Webpage are explained in the table 
below:

Icon Function

Click this icon to display the General dialog box. See The General 
Dialog Box, page 66, for an explanation of the dialog box fields.

Click this icon to synchronize the KL9108 / KL9116's time with your 
computer's time.

If both are in the same time zone, the device's time is changed to 
match the computer's time.

If they are in different time zones, the device's time is changed to 
match the computer's time, except that the time zone difference is 
still maintained.

Click this icon to install new versions of the KL9108 / KL9116's 
firmware. See page 61 for details.
Note: The Firmware icon only displays for users with administrative 
permission. It doesn't appear on the Webpages of users who don't 
have the proper permission.

You should always click this icon to log out and end your KL9108 / 
KL9116 session. If you close the browser without first logging out, 
you will have to wait approximately one minute before logging in 
again unless multiuser operation is enabled (see Customization, 
page 55).
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The General Dialog Box
The General dialog box is the default Webpage. An explanation of the dialog 
box fields is given in the table below:

Note: New versions of the KL9108 / KL9116's firmware can be downloaded 
from our Website as they become available. See page 61 for details.

Field Purpose

Device Name To make it easier to manage installations that have more than 
one KL9108 / KL9116.

MAC Address The KL9108 / KL9116's MAC Address displays here.

Firmware Version Indicates the KL9108 / KL9116's current firmware version level.

Network Transfer 
Rate

Displays the currently selected rate for data transmission. The 
network transfer rate is administrator selectable – see Network 
Transfer Rate, page 47.

Reset on exit Select this check box to reset the KL9108 / KL9116 and 
implement new settings when you log out. Following a reset, wait 
one to two minutes before logging back in. (This check box is 
only enabled for users who have administration privileges.)
Note: For some changes the Reset on exit check box is 
automatically selected and the KVM switch will reset when you 
log out. Clearing the check mark before logging out will cause 
the new settings to be discarded.

Last IP from DHCP 
server

Displays the current IP address of the KL9108 / KL9116.
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Webpage Buttons
The purpose of the buttons at the left of the Webpage are explained in the table 
below:

Icon Purpose

Click this button to download the Windows Client software to 
remotely control the connected computer(s).
Note: You must download a new Windows Client each time 
you log in from your browser.

For platform independence, the Java client allows users that 
have Java installed to connect to the KL9108 / KL9116. Click 
this button to download the Java Client software to remotely 
control the connected server(s).
Note: You must download a new Java Client each time you 
log in from your browser.

In some instances, administrators don't want the KL9108 / 
KL9116 to be accessible by browser. Clicking this button 
allows the user to download the API version of the Windows 
Client. Once a user has downloaded the API program, the 
administrator can turn off browser access. API operation is 
discussed in Chapter 9.

In some instances, administrators don't want the KL9108 / 
KL9116 to be accessible by browser. Clicking this button 
allows the user to download the API version of the Java 
Client. Once a user has downloaded the API program, the 
administrator can turn off browser access. API operation is 
discussed in Chapter 9.

Clicking this button allows the administrator to download 
and install the Log Server application. See Chapter 9 for Log 
Server details.

If a Power on the NET™ (PON) module is connected to the 
KL9108 / KL9116, clicking this button brings up it's interface.

All the events that take place on the KL9108 / KL9116 are 
recorded in a log file. Clicking this icon displays the contents 
of the log file.
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Chapter 6
Windows Client Port Operation

Activating the OSD

After you have successfully logged in (see page 63), to activate the browser-
based Windows Client OSD do the following:

1. Click the Windows Client button (the one without the arrow) at the left of 
the Webpage.

Note: 1. You must have DirectX 7.0 or higher installed on your computer. 
If not, the Windows Client will not load. If you don't already have 
it, DirectX is available for free download from Microsoft's 
Website: http://www.microsoft.com/downloads.

2. The Windows Client button with the arrow is for running the AP 
version of the Windows Client (see page 113 for details).

2. When the file download security warning dialog box appears, click Run.

3. If a second security warning dialog box appears, click Run again.

Note: 1. If the browser cannot run the file, save it to disk, instead. Then, 
with your browser still open to the KL9108 / KL9116 Webpage, 
run the file from your disk.

2. If you use the save to disk method, for security purposes, you 
cannot simply run a previously downloaded version of the 
program. Each time you want to access the KL9108 / KL9116, 
you must log in to the Webpage with a valid username and 
password to download a fresh copy of the program.

(Continues on next page.)
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(Continued from previous page.)

4. When a connection to the KL9108 / KL9116 has been established, the 
screen opens to the Windows Client OSD with the Main page and 
Windows Client Control Panel displayed:
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Before you Begin
Discussion of the Windows Client OSD begins on page 74, but the first time 
you run the program, you may want to make some display configuration 
changes. To do so, Click the curved Arrow icon on the Control Panel at the 
lower right of the remote display. a screen similar to the one below appears

There are three buttons: Config, Switch, and Exit. Their actions are described 
in the table, below:

Button Action

Config Brings up the Graphics Configuration dialog box, which allows you 
to set up the graphical environment. The Graphics Configuration 
dialog box is discussed in the next section.

Switch Switches you to the Windows Client OSD. The Windows Client 
OSD is discussed on page 74.

Exit Ends the program and closes the application.
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Graphics Configuration Dialog Box

The dialog box is organized into two main parts: Screen Options, and Snapshot

Screen Options
Screen options lets you set up the way the remote display appears on the local 
monitor:

If Full Screen Mode is enabled (the box is checked), the remote display 
fills the entire screen.
If Full Screen Mode is not enabled (the box is not checked), the remote 
display appears as a window on the local desktop. If the remote screen is 
larger than what is able to fit in the window, move the mouse pointer to the 
screen border that is closest to the area you want to view and the screen 
will scroll.
If Keep Screen Size is enabled (the box is checked), the remote screen is 
not resized.

If the remote resolution is smaller than that of the local monitor, its 
display appears like a window centered on the screen.
If the remote resolution is larger than that of the local monitor, its 
display is centered on the screen. To access the areas that are off 
screen, move the mouse to the corner of the screen that is closest to the 
area you want to view and the screen will scroll.

If Keep Screen Size is not enabled (the box is not checked), the remote 
screen is resized to fit the local monitor's resolution.
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Snapshot
These settings let the user configure the KL9108 / KL9116’s screen capture 
parameters (see Windows Client Control Panel, page 75):

Path lets you select a directory that the captured screens automatically get 
saved to. Click Browse; navigate to the directory of your choice; then 
click OK.
Click a radio button to choose whether you want the captured screen to be 
saved as a BMP or a JPEG (JPG) file.
If you choose JPEG, you can select the quality of the captured file with the 
slider bar. The higher the quality, the better looking the image, but the 
larger the file size.

Finishing Up
After you have finished making your configuration settings:

1. Click OK to close the dialog box.

2. Click Switch to go back to the Windows Client OSD Main page.
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The Windows Client OSD

After you switch to the KL9108 / KL9116 the OSD comes up with the Main 
page and Windows Client Control Panel displayed:

The OSD consists of three pages – Main, Configuration, and Administration.
The Configuration and Administration pages are discussed in Chapter 4.
The Main page is introduced later in this chapter, on page 84.

Note: The Administration tab is disabled for users who don't have 
administration privileges.
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Windows Client Control Panel

The Windows Client Control Panel consists of an icon bar at the top, with two 
text bars below it. Ordinarily, the text bars display the video resolution and IP 
address of the device at the remote location. As the mouse pointer moves over 
the icons in the icon bar, however, the text bar information changes to describe 
the icon's function.

The functions that the icons perform are described in the table below.

Icon Function

Click and drag to move the control panel to another position on the 
screen.

Click to bring up the Hotkey Setup dialog box (see Hotkey Setup, 
page 76 for details).

Click to bring up the Video Options dialog box. Right-click to perform 
a quick Auto Sync (see Video Adjustment, page 78).

Left click this icon to toggle Full Screen Mode on and off. Right click 
this icon to toggle Keep Screen Size on and off. See Graphics 
Configuration Dialog Box, page 72, for details.

Click to take a snapshot of the remote screen. The captured screen is 
saved in the directory you set up in the Graphics Configuration dialog 
box. See Graphics Configuration Dialog Box, page 72, for details.

Click to bring up the Message Board (see The Message Board, 
page 81, for details).

Click to send a Ctrl+Alt+Del signal to the remote system.

Click to exit the remote view.

These Lock Key LEDs show the Num Lock, Caps Lock, and Scroll 
Lock status of the remote computer. Click on the icon to toggle the 
status.
Note: When you first connect, the LED display may not be accurate. 
To be sure, click on the LEDs to set them.
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Hotkey Setup
Various actions related to manipulating the remote server can be 
accomplished with hotkeys. The Hotkey Setup utility (accessed by 

clicking the Keyboard icon on the Control Panel), lets you configure which 
hotkeys perform the actions. The actions are listed in the left panel; the hotkeys 
that invoke them are shown in the panel at the right.

If you find the default Hotkey combinations inconvenient, you can reconfigure 
them as follows:

1. Highlight the Action, then click Start.

2. Key in the Function keys (one at a time). The key names appear in the Key 
field as you press them.

3. When you have finished keying in your sequence, click Stop.

4. Click Set.

5. Click Close.

Note: You can use the same function keys for more than one action, as long 
as the first key is not the same. For example, you can use F1 F2 F3 for 
one action; F2 F1 F3 for another; F3 F2 F1 for a third, etc.
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An explanation of the Hotkey actions is given in the table below:

Note: To invoke an action, you must press and release the keys one key at a 
time.

Action Explanation

Exit remote location Breaks the connection to the KL9108 / KL9116 and returns 
you to local operation.

Adjust Video Brings up the video adjustment utility.

Toggle OSD Toggles the OSD display Off and On.

Toggle mouse display If you find the display of the two mouse pointers (local and 
remote) to be confusing or annoying, you can use this 
function to shrink the non-functioning pointer down to a 
barely-noticeable tiny circle - which can be ignored. Since this 
function is a toggle - use the hotkeys again to bring the 
mouse display back to its original configuration.

Adjust mouse This utility synchronizes the local and remote mouse 
movements following a video resolution change. After 
invoking this utility, simply click the local mouse pointer on top 
of the remote mouse pointer.

Video Auto-sync This combination performs an auto-sync operation. It is the 
same as clicking the Auto-sync button in the Video Options 
dialog box (see Video Adjustment, page 78).

Substitute Alt key Although all other keyboard input is captured and sent to the 
KL9108 / KL9116, [Alt + Tab] and [Ctrl + Alt + Del] work on 
your local computer. In order to implement their effects on the 
remote system, another key may be substituted for the Alt 
key. If you substitute the F12 key, for example, you would use 
[F12 + Tab] and [Ctrl + F12 + Del].

Substitute Ctrl key If your local computer captures Ctrl key combinations, 
preventing them from being sent to the remote system, you 
can implement their effects on the remote system by 
specifying a function key to substitute for the Ctrl key. If you 
substitute the F11 key, for example, pressing [F11 + 5] would 
appear to the remote system as [Ctrl + 5].
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Video Adjustment
The Video options dialog box allows you to adjust the placement and 
picture quality of the remote screen (as displayed on your monitor). To 

bring up the dialog box, either click on the Hammer icon on the Control Panel, 
or use the Adjust Video and Video Auto-sync hotkeys (see Hotkey Setup, 
page 76).
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The meanings of the video adjustment options are given in the table below:

Option Usage

Screen Position Adjust the horizontal and vertical position of the remote 
computer window by Clicking the Arrow buttons.

Auto-Sync Click Auto-Sync to have the function detect the vertical and 
horizontal offset values of the remote screen and automatically 
synchronize it with the local screen.
If the local and remote mouse pointers are out of sync, in most 
cases, performing this function will bring them back into sync.
Note: This function works best with a bright screen.
If you are not satisfied with the results, use the Screen Position 
arrows to position the remote display manually.

RGB Drag the slider bars to adjust the RGB (Red, Green, Blue) 
values. When an RGB value is increased, the RGB component 
of the image is correspondingly increased.
If you enable Set to Grayscale, the remote video display is 
changed to grayscale.

Gamma This section allows you to adjust the video display's gamma 
level. This function is discussed in detail in the next section, 
Gamma Adjustment.

Video Quality Drag the slider bar to adjust the overall Video Quality. Values can 
be from 20 to 100. The larger the value, the clearer the picture 
and the more video data goes through the network. Depending 
on the network bandwidth, a high value may adversely effect 
response time.

Enable Refresh The KL9108 / KL9116 can redraw the screen every 1 to 99 
seconds, eliminating unwanted artifacts from the screen. Select 
Enable Refresh and enter a number from 1 through 99. The 
KL9108 / KL9116 will redraw the screen at the interval you 
specify. This feature is disabled by default. Click to put a check 
mark in the box next to Enable Refresh to enable this feature.

Color Depth Control This setting adjusts the amount of color information for the video 
data sent over the network. The richer the color, the greater the 
data. For slow data connections, drag the slider bar to a lower 
setting to decrease the amount of video data transferred. This 
ensures screen refresh at workable speeds.

Transparency Adjusts the transparency of the toolbars displayed by the 
Windows and Java Client applications. Slide the bar until the 
display in the Demo window is to your liking.
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Gamma Adjustment
If it is necessary to correct the gamma level for the remote video display, use 
the Gamma function of the Video Adjustment dialog box.

Under Basic configuration, there are ten preset and four user-defined 
levels to choose from. Drop down the list box and choose the most suitable 
one.
For greater control, clicking the Advanced button brings up the following 
dialog box:

Click and drag the diagonal line at as many points as you wish to achieve 
the display output you desire.
Click Save As to save up to four user-defined configurations derived from 
this method. Saved configurations can be recalled from the list box at a 
future time.
Click Reset to abandon any changes and return the gamma line to its 
original diagonal position.
Click OK to save your changes and close the dialog box.
Click Cancel to abandon your changes and close the dialog box.

Note: For best results, change the gamma while viewing a remote computer.
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The Message Board
The KL9108 / KL9116 supports multiple user logins, which can 
possibly give rise to access conflicts. To alleviate this problem, a 

message board feature has been provided, allowing users to communicate with 
each other.

The message board functions much like an Internet chat program does. When 
you click the Message Board icon on the Windows Client Control Panel (see 
page 75), a screen similar to the one below appears:
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The Button Bar
The buttons on the Button Bar are toggles. Their actions are described in the 
table below:

Message Display Panel
Messages that users post to the board - as well as system messages - display in 
this panel. If you disable Chat, however, messages that get posted to the board 
won't appear.

Compose Panel
Key in the messages that you want to post to the board in this panel. Click 
Send, or press [Enter] to post the message to the board.

Button Action

Enable/Disable Chat. When disabled, messages posted to the board 
are not displayed. The button is shadowed when Chat is disabled. The 
icon displays next to the user's name in the User List panel when the 
user has disabled Chat.

Occupy/Release Keyboard/Video/Mouse. When you Occupy the 
KVM, other users cannot see the video, and cannot input keyboard or 
mouse data. The button is shadowed when the KVM is occupied. The 
icon displays next to the user's name in the User List panel when the 
user has occupied the KVM.

Occupy/Release Keyboard/Mouse. When you Occupy the KM, other 
users can see the video, but cannot input keyboard or mouse data. 
The button is shadowed when the KM is occupied. The icon displays 
next to the user's name in the User List panel when the user has 
occupied the KM.

Show/Hide User List. When you Hide the User List, the User List panel 
closes. The button is shadowed when the User List is open.
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User List Panel
The names of all the logged in users are listed in this panel.

Your name appears in blue; other users' names appear in black.
By default, messages are posted to all users. To post a message to one 
individual user, select the user's name before sending your message.
If a user's name is selected, and you want to post a message to all users, 
select All Users before sending your message.
If a user has disabled Chat, its icon displays before the user's name to 
indicate so.
If a user has occupied the KVM or the KM, its icon displays before the 
user's name to indicate so.
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The Main Page

The Main Page lists all of the KL9108 / KL9116's ports and governs port 
access. Double clicking a port switches you to the device on that port.

Note: The administrator selects which ports are accessible to each user (see 
User Management, page 42).

The Main Page uses a tree view to organize the port display. To see the 
ports for a particular station, click the plus sign [ + ] in front of the Station 
Number. The Port Number List drops down. To dismiss the list, click the 
minus sign[ – ] in front of the Station Number.
A port icon in the shape of a monitor displays in front of the port number. 
Ports that have devices connected to them that are up and running have the 
port icon lit in green.
Ports that have been selected as Quick View ports (see below), have a red 
eye icon displayed with the monitor in the port icon column to indicate so.
There are two buttons on the title bar at the top right:

Button Function

Log out: clicking this button (or pressing F8) closes the OSD 
display and logs you out of the KL9108 / KL9116 session.

Close: clicking this button (or pressing [Esc]) closes the OSD 
display but does not log you out of the session. You can bring the 
display back with the OSD hotkeys (see OSD Hotkey, page 40).
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Port Operation

Select a port on the OSD Main Screen either by moving the highlight bar to it 
with the Up and Down Arrow keys and pressing Enter, or by double-clicking 
it. Once you select a port, its screen displays on your monitor, and your 
keyboard and mouse input affects the remote system.

The OSD Toolbar
The OSD provides a toolbar to help you control the KL9108 / KL9116 from 
within the captured port. To bring up the toolbar, tap the OSD Hotkey (Scroll 
Lock or Ctrl) twice. The toolbar appears in the upper left corner of the screen:

Depending on the settings that were selected under ID Display (see page 40), 
the Port Number and/or the Port Name display at the right of the toolbar.

Note: 1. Click on a free area of the toolbar and drag to move it around the 
screen.

2. When the toolbar displays, mouse input is confined to the toolbar area 
and keyboard input has no effect. To carry out operations on the 
computer connected to the port, close the toolbar by clicking the X on 
it; or, recall the OSD and select the port again.

Recalling the OSD
To dismiss the toolbar and bring back the OSD display (the Main, 
Configuration, and Administration pages), do one of the following:

Tap the OSD Hotkey once.
From the toolbar, click the icon that opens the OSD (see OSD Toolbar 
Icons, page 86).

The toolbar closes, and the main OSD display reappears.
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OSD Hotkey Summary Table
The following table presents a summary of the OSD Hotkey actions. See p. 40 
to set the OSD Hotkey.

OSD Toolbar Icons
The meanings of the toolbar icons are explained in the table below.

To... When... Do This...

Open the OSD 
Toolbar.

The OSD Toolbar is not open. Click the OSD Hotkey twice.

Open the OSD. The OSD Toolbar is open. Click the OSD Hotkey once.

Open the OSD. The OSD Toolbar is not open. Click the OSD Hotkey three times.

Click to skip to the first accessible port on the entire installation without 
having to invoke the OSD.

Click to skip to the first accessible port previous to the current one without 
having to invoke the OSD.

Click to begin Auto Scan Mode. The KL9108 / KL9116 automatically 
switches among the ports that were selected for Auto Scanning under the 
Configuration Scan Select function (see page 40). This allows you to 
monitor their activity without having to switch among them manually.

Click to skip from the current port to the next accessible one without having 
to invoke the OSD.

Click to skip from the current port to the last accessible port on the entire 
installation without having to invoke the OSD.

Click to bring up the OSD.

Click to close the toolbar.

Click to logout and exit the Windows Client application.

Click to invoke Panel Array Mode (see page 87).
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Panel Array Mode
Clicking on the OSD Toolbar's Panel icon invokes Panel Array Mode. Under 
this mode, the OSD divides your screen into a 4 x 4 grid of 16 panels:

Each panel represents one of the KL9108 / KL9116's ports. Starting with 
Port 1 at the upper left; going from left to right; top to bottom; Port 16 is at 
the lower right.
When the Array is first invoked, it scans through each of the ports that 
were selected for Auto Scanning under the Configuration page's Scan 
Select function (see page 40), and displays information about the port (port 
name, resolution, on line status, port access status), at the bottom of the 
panel.
The number of panels in the array (16, 9, 4, or 1) can be selected by 
clicking Show More Ports (+), and Show Fewer Ports (-) on the panel 
array toolbar. 
If the computer connected to a port is on line, its screen displays in its 
panel, otherwise the panel is blank.
Only ports that are accessible to the currently logged in user display (see 
Port Access, page 44). All other panels are blank.
If you move the mouse pointer over a panel, information about the port 
displays at the bottom of the screen.
You can access a computer connected to a port by moving the mouse 
pointer over its panel and clicking. You switch to the computer exactly as 
if you had selected it from the OSD Main screen.
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Panel Array Toolbar
The panel array toolbar, at the lower right of the screen, provides shortcut 
navigation and control of the panel array as described in the table below:

Note: 1. We recommend that the user who starts Panel Array Mode set it to 
display at least four panels; otherwise, it is possible that other users 
may receive only part of the picture.

2. For issues affecting multiple user operation in Panel Array Mode, see 
Multiuser Operation, page 89.

Click and drag to move the toolbar to another position on the screen.

Pause panel scanning, leaving the focus on the panel that currently has it.

Move back four panels.

Move to the previous panel.

Move to the next panel.

Move ahead four panels.

Increase the number of panels in the array.

Decrease the number of panels in the array.

Toggle 4/3 aspect ratio.

Exit Panel Array mode.
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Multiuser Operation

The KL9108 / KL9116 supports multiuser operation. Up to 32 users can log in 
at the same time. When multiple users simultaneously access the KL9108 / 
KL9116 switch from remote computers, the rules of precedence that apply are 
shown in the following table:

Note: We recommend that the user who starts Panel Array Mode set it to 
display at least four panels; otherwise, it is possible that other users may 
receive only part of the picture.

Operation Rule

General Once a user invokes the OSD, no other user can invoke it until 
the original user closes it.

Auto Scan Mode If a user has invoked Auto Scan Mode (see page 90), but the 
OSD has not been invoked, another user can interrupt Auto 
Scan Mode by invoking the OSD.

Panel Array Mode When a user has invoked Panel Array Mode (see page 87), 
all successive users automatically enter Panel Array Mode. 
Panel Array Mode continues until the original user stops it. 
(Administrators can override Panel Array Mode.)

Only the user who starts Panel Array Mode can use the Skip 
Mode (see page 91) function.

Only the user who starts Panel Array Mode can switch ports. 
Other users automatically switch to the ports that the original 
user selects. However, if an individual user does not have 
access rights to the port that the original user switches to, 
the user will not be able to view that port.

Individual users can increase or decrease the number of 
panels they wish to view in Panel Array Mode; however, the 
picture quality may decrease as the number of panels 
decreases.
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Keyboard Hotkey Operation

Keyboard hotkey combinations allow you to provide KVM focus to a port 
directly from the keyboard. The KL9108 / KL9116 provides the following 
hotkey features:

Auto Scanning
Skip Mode Switching

The hotkeys are: A and P for Auto Scanning; and the Arrow Keys for Skip 
Mode.

Note: 1. In order for hotkey operations to take place, the OSD Toolbar must be 
visible (see Port Operation, page 85).

2. To use the keys designated as hotkeys (i.e. A, P, etc.) for normal, non-
hotkey purposes, you must first close the toolbar.

3. For issues affecting multiple user operation in Auto Scan Mode, see 
Multiuser Operation, page 89.

Auto Scanning
The Auto Scan function automatically switches among all the ports that are 
accessible to the currently logged on user at regular intervals, so that the user 
can monitor their activity automatically. (See Scan Select, page 40, for 
information regarding accessible ports.)

Setting the Scan Interval
The amount of time Auto Scan dwells on each port is set with the Scan 
Duration setting (see page 40).

Invoking Auto Scan
To start Auto Scanning, with the toolbar showing, tap the A key. The Auto 
Scan function cycles through the ports in order - starting from the first port on 
the installation. An  appears in front of the Port ID Display to indicate that 
the port is being accessed under Auto Scan Mode.

S
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Pausing Auto Scan
While you are in Auto Scan Mode, you can pause the scanning in order to keep 
the focus on a particular computer by pressing P. During the time that Auto 
Scanning is paused, the S in front of the Port ID blinks On and Off.

Pausing when you want to keep the focus on a particular computer can be more 
convenient than exiting Auto Scan Mode because when you Resume scanning, 
you start from where you left off. If, on the other hand, you were to exit and 
then restart Auto Scan Mode, the scanning would start over from the very first 
computer on the installation.

To Resume Auto Scanning after a pause, press any key except [Esc] or the 
[Spacebar]. Scanning continues from where it left off.

Exiting Auto Scan
While Auto Scan Mode is in effect, ordinary keyboard functions are 
suspended. You must exit Auto Scan Mode in order to regain normal control 
of the keyboard. To exit Auto Scan Mode press Esc or the Spacebar. Auto 
Scanning stops when you exit Auto Scan Mode.

Skip Mode
Skip Mode allows you to switch ports in order to monitor the computers 
manually. You can dwell on a particular port for as long or as little as you like 
- as opposed to Auto Scanning, which automatically switches after a fixed 
interval. The Skip Mode hotkeys are the four Arrow keys. Their operation is 
explained in the table below:

Arrow Action

← Skips from the current port to the first accessible port previous to it. 
(See Scan Select, page 40, for information regarding accessible ports.)

→ Skips from the current port to the first accessible port that comes after it.

↑ Skips from the current port to the very first accessible port on the 
installation.

↓ Skips from the current port to the very last accessible port on the 
installation.
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Keyboard and Mouse Considerations

Keystrokes
Except for [Alt + Tab] and [Ctrl + Alt + Del], all keyboard input is sent to the 
remote system. The above two chorded key combinations are retained on the 
local system to switch among applications and to recover from disaster. In 
order to provide the [Alt + Tab] and [Ctrl + Alt + Del] functions on the remote 
system, Function keys (F1 -F12) can be selected as substitute keys for both the 
Alt and Ctrl keys.

For example, the F11 key could substitute for the Ctrl key and the F12 key 
could substitute for the Alt key, in which case [F12 + Tab] substitutes for [Alt 
+ Tab]; and [F11 + F12 + Del] substitutes for [Ctrl + Alt + Del]. See Hotkey 
Setup, page 76, for details on setting up a substitute key.

Note: 1. While any key may be used as a Substitute key, you must not use one 
that is being used as the first position Hotkey for another action.

2. When the KL9108 / KL9116 is being accessed with Win 98 under 
Full Screen Mode, if you mistakenly press Ctrl + Alt + Del, you will 
have to exit the Windows Client (by clicking the arrow on the 
Windows Client control panel), and restart the Windows Client from 
the KL9108 / KL9116 Main Webpage.
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Mouse Synchronization
Until you close the KL9108 / KL9116 connection, mouse movements have no 
effect on your local system, but instead are captured and sent to the remote 
system.

From time to time, especially if you change video resolution, the local mouse 
movement may no longer be synchronized with the remote system's mouse 
pointer. There are three quick methods that can be used to bring the two 
pointers back into sync:

Right-clicking on the hammer icon in the Windows Client Control Panel.
Moving the mouse pointer into the Control Panel and back out again.
Performing an Auto Sync with the Video Adjustment function (see Video 
Adjustment, page 78, for details).

If performing these actions does not resolve the problem, do the following:

1. Invoke the Adjust Mouse function with the Adjust Mouse hotkeys (see 
Adjust mouse, page 77, for details).

2. Move the local mouse pointer exactly on top of the remote mouse pointer 
and click.

If this procedure still does not help, you should set the mouse speed and 
acceleration for each problematic computer attached to the switch. 
See Additional Mouse Synchronization Procedures, page 158, for instructions.
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Chapter 7
Java Client Port Operation

Activating the OSD

After you have successfully logged in (see page 63), to activate the Java Client 
OSD do the following:

1. Click the Java Client button (the one without the arrow) at the left of the 
Webpage.

Note: You must have Sun's Java 2 JRE 1.4.2 or higher installed on your 
computer before running the Java Client. (At the time of writing, 
JRE 5.0 Update 5 was the latest release.) Java is available for free 
download from the Sun Java Website: http://java.sun.com.

2. Accept the security certificates.

3. When the browser dialog asks what to do with the program file, click 
Open.

Note: 1. If the browser cannot run the file, save it to the hard drive. Then, 
with your browser still open to the KL9108 / KL9116 Webpage, 
run the file from your disk.

2. If you use the save to disk method, for security purposes, you 
cannot simply run a previously downloaded version of the 
program. Each time you want to access the KL9108 / KL9116, 
you must log in to the Webpage with a valid username and 
password to download a fresh copy of the program.
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The Java Client OSD

When you bring up the OSD, the Main Screen comes up in the center of your 
monitor.

The OSD consists of three pages – Main, Configuration, and Administration.
The Configuration and Administration pages are discussed in Chapter 4.
The Main page is the same OSD Main page that appears when the 
Windows Client is invoked. For an explanation of this page refer to the 
discussion under The Windows Client OSD, page 74.

Note: The Administration tab is disabled for users who don't have 
administration privileges.

The Java Client Control Panel

Instead of a control panel like the one that the Windows Client uses, the Java 
Client has a hidden control panel, located at the bottom center of the screen. 
The panel becomes visible when the mouse pointer is moved over it.

The Java Client Control Panel icons and their functions are described in the 
sections that follow.
96



 Chapter 7. Java Client Port Operation
Set Video Parameters
Clicking this button brings up the Video Adjustment dialog box:

It is similar to the Windows Client Video Adjustment dialog box. See Video 
Adjustment, page 78, for details.

Keypad
Some keyboard combinations cannot be captured and sent to the 
KL9108 / KL9116. In order to implement their effects on the remote 

system, this function provides a one-click implementation of some common 
window control combinations.
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Mouse Synchronization 
At times the local mouse movement may lose sync with the remote 
mouse movement. The Mouse Synchronization function gets them 

back into sync. There are two methods available to bring the pointers into sync:

1. Click the Mouse Synchronization button; wait for the remote mouse 
pointer to move to the upper left corner of the screen; move your local 
mouse pointer directly on top of the remote pointer, and click.

2. Move your local mouse pointer over the Java Client Control Panel, and 
click.

Message Board
The KL9108 / KL9116 supports multiple user logins, which can 
possibly give rise to access conflicts. To alleviate this problem, a 

message board feature, similar to an Internet chat program, allows users to 
communicate with each other. 

When you click the Message Board icon on the Java Client Control Panel (see 
page 96), a screen similar to the one below appears:
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The Message Board Button Bar
The buttons on the Button Bar are toggles. Their actions are described in the 
table below:

Messages that users post to the board - as well as system messages - 
display in the Message Display panel. If you disable Chat, however, 
messages that get posted to the board won't appear. 
Key in the messages that you want to post to the board in the Compose 
panel. Click Send, to post the message to the board. 
The names of all the logged in users appear in the User List panel. 

Button Action

Enable/Disable Chat. When disabled, messages posted to the 
board are not displayed. The button is shadowed when Chat is 
disabled. The icon displays next to the user's name in the User List 
panel when the user has disabled Chat.

Occupy/Release Keyboard/Video/Mouse. When you Occupy the 
KVM, other users cannot see the video, and cannot input keyboard 
or mouse data. The button is shadowed when the KVM is occupied. 
The icon displays next to the user's name in the User List panel 
when the user has occupied the KVM.

Occupy/Release Keyboard/Mouse. When you Occupy the KM, 
other users can see the video, but cannot input keyboard or mouse 
data. The button is shadowed when the KM is occupied. The icon 
displays next to the user's name in the User List panel when the 
user has occupied the KM.
99



KL9108 / KL9116 User Manual
By default, messages are posted to all users. To post a message to one 
individual user, select the user's name before sending your message. 
If a user's name is selected, and you want to post a message to all users, 
select All Users before sending your message. 
If a user has disabled Chat, its icon displays before the user's name to 
indicate so. 
If a user has occupied the KVM or the KM, its icon displays before the 
user's name to indicate so. 
To Hide/Unhide the User List panel, click on the arrows in the panel 
separator.
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Lock Key LEDs and Resolution
These LEDs show the Num Lock, Caps Lock, and Scroll Lock 
status of the remote computer. They turn Green when the Lock 

status is On. Click on the icon to toggle the status.

Note: When you first connect, the LED display may not be accurate. To be 
sure, click on the LEDs to set them.

The video resolution of the device connected to the remote port displays 
directly below the Lock LEDs.

Switch Screen Mode
Clicking this button toggles Full Screen Mode on and off. (By default 
the Java Client opens in Full Screen Mode.)

About
Clicking this button opens the About dialog box, which displays the 
Java Client Version information. Click the OK button to close the 

dialog box.

Send Ctrl+Alt+Del
Clicking this button sends a Ctrl+Alt+Del signal to the remote system.

Help
Clicking this button brings up the online help screen for the Java 
Client.

Exit
Clicking the Exit button terminates the Java Client session.
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Port Operation

Java Client port operation is the same as for the Windows Client. See Port 
Operation, page 85, for details.

Panel Array Mode
This is very similar to the Windows Client Panel Array Mode (see page 87 for 
details), except for some differences in the toolbar. The Java Client Panel Array 
Mode Toolbar is described in the table below:

Keyboard Hotkey Operation

Keyboard hotkey operation is the same as for the Windows Client. 
See Keyboard Hotkey Operation, page 90, for details.

Pauses panel scanning, leaving the focus on the panel that had it when you 
clicked. After you click Pause, he button changes to an arrowhead and its 
caption changes to Resume. To resume scanning, click the Resume button.

Move back four panels.

Move to the previous panel.

Move to the next panel.

Move ahead four panels.

Increase the number of panels in the array.

Decrease the number of panels in the array.

Toggle 4/3 aspect ratio.

Exit Panel Array mode.
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Chapter 8
The Log File

The Main Screen

The KL9108 / KL9116 logs all the events that take place on it. To view the 
contents of the log file, click the Log icon at the left of the Webpage. A screen 
similar to the one below appears:

A maximum of 512 events are stored in the log file. To clear the log file, click 
on the Clear Log icon at the lower right of the screen.

Note: The Log File is a temporary file that is erased when the KL9108 / 
KL9116 is turned off or loses power. It is recommended that you install 
the Log Server to backup the contents of the log file.
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Chapter 9
The Log Server

The Windows-based Log Server is an administrative utility that records all the 
events that take place on selected KL9108 / KL9116 units and writes them to 
a searchable database. This chapter describes how to install and configure the 
Log Server.

Installation

1. From the computer that you want to use as the Log Server, open your 
browser and log into the KL9108 / KL9116 (see page 63).

2. Click the Log Server button at the left of the Webpage to start the Log 
Server installation program.

3. If any security warning dialog boxes appear, ignore them and click Run or 
Open.

Note: If the browser cannot run the file, save it to disk, instead, and run the 
file from your disk.

4. Click Next. Then follow the on-screen instructions to complete the 
installation and have the Log Server program icon placed on your desktop.
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Starting Up

To bring up the Log Server, either double click the program icon, or key in the 
full path to the program on the command line. The first time you run it, a screen 
similar to the one below appears:

Note: 1. The MAC address of the Log Server computer must be specified on 
the Service Configuration page of the Administrator Utility (see 
page 45).

2. The Log Server requires the Microsoft Jet OLEDB 4.0 driver in order 
to access the database.

The screen is divided into three components:
A Menu Bar at the top
A panel that will contain a list of KL9108 / KL9116 units in the middle 
(see The Log Server Main Screen, page 111, for details).
A panel that will contain an Events List at the bottom

Each of the components is explained in the sections that follow.
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The Menu Bar

The Menu bar consists of four items: 
Configure
Events
Options
Help

These are discussed in the sections that follow.

Note: If the Menu Bar appears to be disabled, click in the KL9108 / KL9116 
List window to enable it.

Configure
The Configure menu contains three items: Add, Edit, and Delete. They are used 
to add new KL9108 / KL9116 units to the KL9108 / KL9116 List; edit the 
information for units already on the list; or delete KL9108 / KL9116 units from 
the list.y

To add a KL9108 / KL9116 to the KL9108 / KL9116 List, click Add.
To edit or delete a listed KL9108 / KL9116, first select the one you want in 
the KL9108 / KL9116 List window, then open this menu and click Edit or 
Delete.

When you choose Add or Edit, a dialog box, similar to the one below appears:
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A description of the fields is given in the table, below:

Fill in or modify the fields, then click OK to finish.

Events
The Events Menu has two items: Search and Maintenance.

Search

Search allows you to search for events containing specific words or strings. 
When you access this function, a screen similar to the one below appears:

Field Explanation

Address This can either be the IP address of the KL9108 / KL9116 or its DNS 
name (if the network administrator has assigned it a DNS name).

Port The port number that was assigned to the Log Server in the KL9108 / 
KL9116 OSD (see Log Server, page 46).

Description This field is provided so that you can put in a descriptive reference for 
the unit to help identify it.

Limit This specifies the number of days that an event should be kept in the 
Log Server's database before it expires and it is cleared out.
108



 Chapter 9. The Log Server
A description of the items is given in the table below:

Maintenance
This function allows the administrator to perform manual maintenance of the 
database, such as erasing specified records before the expiration time that was 
set with the Limit setting of the Edit function (see page 108).

Item Explanation

New search This is one of three radio buttons that define the scope of the 
search. If it is selected, the search is performed on all the 
events in the database for the selected KL9108 / KL9116.

Search last results This is a secondary search performed on the events that 
resulted from the last search.

Search excluding last 
results

This is a secondary search performed on all the events in the 
database for the selected KL9108 / KL9116 excluding the 
events that resulted from the last search.

Server List KL9108 / KL9116 units are listed according to their IP 
address. Select the unit that you want to perform the search 
on from this list. You can select more than one unit for the 
search. If no units are selected, the search is performed on all 
of them.

Priority List Sets the level for how detailed the search results display 
should be. 1 is the most general; 3 is the most specific.

Start Date Select the date that you want the search to start from. The 
format follows the MM/DD/YYYY convention, as follows:
11/04/2005

Start Time Select the time that you want the search to start from.

End Date Select the date that you want the search to end at.

End Time Select the time that you want the search to end at.

Pattern Key in the pattern that you are searching for here. The 
multiple character wildcard (%) is supported. E.g., h%ds 
would match hands and hoods.

Results Lists the events that contained matches for the search.

Search Click this button to start the search.

Print Click this button to print the search results.

Exit Click this button to exit the Search dialog box.
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Options
Network Retry allows you to set the number of seconds that the Log Server 
should wait before attempting to connect if the previous attempt to connect 
failed. When you click this item, a dialog box, similar to the one below appears:

Key in the number of seconds, then click OK to finish.

Help
From the Help Menu, click Contents to access the online Windows Help file. 
The help file contains instructions about how to setup, operate and troubleshoot 
the Log Server.
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The Log Server Main Screen

Overview
The Log Server Main Screen is divided into two main panels.

The upper (List) panel lists the KL9108 / KL9116 units that have been 
selected for the Log Server to track (see Configure, page 107).
The lower (Event) panel displays the log events for the currently selected 
KL9108 / KL9116 (the highlighted one - if there are more than one). To 
select a KL9108 / KL9116 unit in the list, simply click on it.
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The List Panel
The List panel contains six fields:

The Event Panel
The lower panel displays tick information for the currently selected KL9108 / 
KL9116. Note that if the installation contains more than one switch, even 
though a switch isn’t currently selected, if its Recording checkbox is checked, 
the Log Server records its tick information and keeps it in its database.

Field Explanation

Recording Determines whether the Log Server records log events for 
this KL9108 / KL9116 or not. If the Recording check box is 
checked, the field displays Recording, and log events are 
recorded. If the Recording check box is not checked, the field 
displays Paused, and log events are not recorded.
Note: Even though a KL9108 / KL9116 is not the currently 
selected one, if its Recording check box is checked, the Log 
Server will still record its log events.

Address This is the IP Address or DNS name that was given to the 
KL9108 / KL9116 when it was added to the Log Server (see 
Configure, page 107).

Port This is the port number that was assigned to the Log Server 
in the KL9108 / KL9116 OSD (see Log Server, page 46).

Connection If the Log Server is connected to the KL9108 / KL9116, this 
field displays Connected.
If it is not connected, this field displays Waiting. This means 
that the Log Server's MAC address has not been set properly. 
It needs to be set on the Service Configuration page of the 
Administrator Utility (see page 45).

Days This field displays the number of days that the KL9108 / 
KL9116's log events are to be kept in the Log Server's 
database before expiration (see Configure, page 107).

Description This field displays the descriptive information given for the 
KL9108 / KL9116 when it was added to the Log Server (see 
Configure, page 107).
112



Chapter 10
AP Operation

Overview

In some cases, the Administrator may not want the KL9108 / KL9116 to be 
available via browser access. AP versions of the Windows Client and the Java 
Client are provided to enable direct access of the KL9108 / KL9116 without 
having to go through a browser.

The programs are initially downloaded from the browser page. After they have 
been downloaded by the Users, the Administrator can disable browser access 
(see Working Mode, page 55).

The Windows Client

Installation
To install the Windows Client on your computer, do the following:

1. Log into the KL9108 / KL9116 with your browser, and click the second 
Windows Client button (the one with the arrow). A screen similar to the 
one below appears:

2. Click Save.

3. In the dialog box that comes up specify a location on your hard disk to 
save it to.
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Starting Up
To connect to the KL9108 / KL9116, go to the location on your hard disk that 
you saved the Windows Client program to, and double-click its icon 
(WinClient.exe) to bring up the Windows Client Connection Screen:

Note: You must have DirectX 7.0 or higher installed on your computer. If not, 
the Client program will not load.

(Continues on next page.)
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(Continued from previous page.)

A description of the Connection Screen is given in the following table:

Item Description

Menu Bar The Menu Bar contains three items: File, Tools, and Help.

The File Menu allows the operator to Create, Save, and 
Open user created Work files (see page 116 for details).

The Tools Menu contains two entries: Keyboard and 
Config, (see page 116 for details).

Server List Each time the WinClient.exe file is run, it searches the User's 
local LAN segment for KL9108 / KL9116 units, and lists 
whichever ones it finds in this box. If you want to connect to 
one of these units, double-click it.

Server This area is used when you want to connect to a KL9108 / 
KL9116 at a remote location. You can drop down the IP list 
box and select an address from the list. If the address you 
want isn't listed, you can key in the IP address you want. 
Then, key in the Port number in the Port field. If you don't 
know the Port number, then contact the Administrator.
When the IP address and Port number for the unit you wish to 
connect to have been specified, Click Connect to start the 
connection. When you have finished with your session, Click 
Disconnect to end the connection.

Message List  Lists status messages regarding the connection to the 
KL9108 / KL9116.

Switch to Remote View Once contact with a KL9108 / KL9116 has been established, 
this button becomes active. Click it to switch and take over 
console control of the unit that is attached to the KL9108 / 
KL9116.
The screen output of the unit appears on your monitor. Your 
keystrokes and mouse movements are captured and sent to 
the KL9108 / KL9116 to be executed on the attached unit.
If the KL9108 / KL9116 is connected to a KVM switch, you 
can control the switch and the computers connected to it just 
as if you were connected locally.

Change Password This button becomes active after a connection to a KL9108 / 
KL9116 unit has been established. It allows the User to 
change the password used to log in to the KL9108 / KL9116.
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The File Menu
The File Menu allows the operator to Create, Save, and Open user created 
Work files. A Work File consists of all the information specified in a Client 
session. This includes the Server List and Server IP list items, as well as the 
Hotkey settings.

Whenever a user runs the Client program, it opens with the values contained in 
the current work file. The current work file consists of the values that were in 
effect the last time the program was closed.

The File menu consists of three items, as follows:

The Tools Menu
Tools menu operations are performed after you connect, but before you switch 
to remote view. There are two entries on the Tools Menu: Keyboard and 
Config. They are explained in the sections that follow.

Keyboard
Various configuration actions related to the keyboard, video, and mouse can be 
performed via hotkey combinations. The Hotkey Setup utility is accessed by 
opening the Tools menu and selecting Keyboard. The Hotkey Setup Screen that 
appears is essentially the same dialog box discussed in the browser-based 
Windows Client chapter. See Hotkey Setup, page 76 for details.

New Allows the user to create a named work file so its values will not 
be lost, and it will be available for future recall.

Open Allows the user to open a previously saved work file and use the 
values contained in it.

Save Allows the user to save the values presently in effect as the 
current work file.
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Config
When you select Config, a screen similar to the one below appears:

The dialog box is organized into two main parts: Screen Options, and Snapshot. 
Screen Options lets you set up the way the remote display appears on the local 
monitor; Snapshot lets the user configure the KL9108 / KL9116’s screen 
capture parameters.

This is the same dialog box that is discussed in the browser-based Windows 
Client Port Operation chapter. See Graphics Configuration Dialog Box, 
page 72, for details.
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Connecting
To connect to a KL9108 / KL9116 unit:

1. If the device that you wish to connect to is in the Server List, double click 
it. If you are using the Server IP input box, specify the IP address and Port 
number, then click Connect. The Login dialog box appears:

2. Key in a valid Username and Password, and then click OK.
The program attempts to connect to the selected KL9108 / KL9116 unit. 
While it does so, you can check the Message List window for status 
messages regarding the operation's progress.

3. Once contact with the KL9108 / KL9116 has been established, the Switch 
to Remote View button becomes active. Click it to connect to the KL9108 / 
KL9116 and take over console control of the unit that is connected to it.
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Operation
Once a connection to the KL9108 / KL9116 has been established, the remote 
system's video output is captured and displayed on your monitor. At the same 
time, your local keystroke and mouse input is captured and sent to the remote 
system.

The look and feel of the AP Windows client operation is the same as for the 
browser version of the Windows client. Refer back to Chapter 6, Windows 
Client Port Operation for details.

Ending the Session
After you log out of the KL9108 / KL9116, you return to the Connection dialog 
box. Click Disconnect to end the session.

The Java Client

Installation
To install the Java Client on your computer, do the following:

1. Log into the KL9108 / KL9116 with your browser, and click the second 
Java Client button (the one with the arrow). A screen similar to the one 
below appears:

2. Click Save.

3. In the dialog box that comes up specify a location on your hard disk to 
save it to.
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Starting Up
To connect to the KL9108 / KL9116, go to the location on your hard disk that 
you saved the Java Client program to, and double click its icon to bring up the 
Address Input dialog box.

Note: The Java Client requires Java version 1.4.2 or higher.

1. Key in the IP address for the unit you want to connect to – including a 
forward slash followed by the login string (set by the administrator), then 
click OK.

Note: For security purposes, the login string must be specified correctly as 
part of the IP address. The system administrator may change the 
string from time to time to thwart unauthorized access attempts. Be 
sure you have the correct string when you attempt to connect.
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2. After you establish a connection, a Login dialog box appears. Provide a 
valid Username and Password, and then click OK.

Once the authentication procedure completes successfully, the KL9108 / 
KL9116 main page displays on your monitor.

Operation
The look and feel of the AP Java client operation is the same as for the browser 
version of the Java client. See Java Client Port Operation, page 95, for details.
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Chapter 11
LDAP Server Configuration

Introduction

The KVM Over the NETTM switch allows log in authentication and 
authorization through external programs. This chapter describes how to 
configure Active Directory for KVM Over the NETTM switch authentication 
and authorization.

To allow authentication and authorization via LDAP or LDAPS, the Active 
Directory’s LDAP Schema must be extended so that an extended attribute 
name for the KVM Over the NETTM switch – ikvm2116-userProfile – is added 
as an optional attribute to the person class.

Note: Authentication refers to determining the authenticity of the person 
logging in; authorization refers to assigning permission to use the 
device’s various functions.

In order to configure the LDAP server, you will have to complete the following 
procedures: 1) Install the Windows Server Support Tools; 2) Install the Active 
Directory Schema Snap-in; and 3) Extend and Update the Active Directory 
Schema.

The following section provides an example of configuring LDAP under 
Windows 2003 Server.

Install the Windows 2003 Support Tools

To install the Windows 2003 Support Tools, do the following:

1. On your Windows Server CD, open the Support → Tools folder.

2. In the right panel of the dialog box that comes up, double click 
SupTools.msi.

3. Follow along with the Installation Wizard to complete the procedure.
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Install the Active Directory Schema Snap-in

To install the Active Directory Schema Snap-in, do the following:

1. Open a Command Prompt.

2. Key in: regsvr32 schmmgmt.dll to register schmmgmt.dll on your 
Active Directory computer.

3. Open the Start menu; click Run; key in: mmc /a; click OK.

4. On the File menu of the screen that appears, click Add/Remove Snap-in; 
then click Add.

5. Under Available Standalone Snap-ins, double click Active Directory 
Schema; click Close; click OK.

6. On the screen you are in, open the File menu and click Save.

7. For Save in, specify the C:\Windows\system32 directory.

8. For File name, key in schmmgmt.msc.

9. Click Save to complete the procedure.

Create a Start Menu Shortcut Entry

To create a shortcut entry on the Start Menu for the Active Directory Schema, 
do the following:

1. Right click Start; select: Open all Users → Programs → Administrative 
Tools.

2. On the File menu, select New → Shortcut

3. In the dialog box that comes up, browse to, or key in the path to 
schmmgmt.msc (C:\Windows\system32\schmmgmt.msc), then click Next.

4. In the dialog box that comes up, key in Active Directory Schema as the 
name for the shortcut, then click Finish.
124



 Chapter 11. LDAP Server Configuration
Extend and Update the Active Directory Schema

To extend and update the Active Directory Schema, you must do the following 
3 procedures: 1) create a new attribute; 2) extend the object class with the new 
attribute; and 3) edit the active directory users with the extended schema.

Creating a New Attribute
To create a new attribute do the following:

1. From the Start menu, open Administrative Tools → Active Directory 
Schema.

2. In the left panel of the screen that comes up, right-click Attributes:

3. Select New → Attribute.

4. In the warning message that appears, click Continue to bring up the 
Create New Attribute dialog box.

(Continues on next page.)
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5. Fill in the dialog box to match the entries for Description and Common 
Name shown below, then click OK to complete the procedure.

Note: The Unique X500 Object ID uses periods, not commas.
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Extending the Object Class With the New Attribute
To extend the object class with the new attribute, do the following:

1. Open the Control Panel → Administrative Tools → Active Directory 
Schema.

2. In the left panel of the screen that comes up, select Classes.

3. In the right panel, right-click person:

4. Select Properties; the person Properties dialog box comes up with the 
General page displayed. Click the Attributes tab.
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5. On the Attributes page, click Add:

6. In the list that comes up, select iKVM2116-userProfile, then click OK to 
complete the procedure.
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Editing Active Directory Users
To edit Active Directory Users With the Extended Schema, do the following:

1. Run ADSI Edit. (Installed as part of the Support Tools.)

2. In the left panel, open Domain, and navigate to the DC=aten,DC=com 
CN=Users node.

3. In the right panel, locate the user you wish to edit. (Our example uses 
jason.)

4. Right-click on the user’s name and select properties.

(Continues on next page.)
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5. On the Attribute Editor page of the dialog box that appears, select 
iKVM2116-userProfile from the list.

6. Click Edit to bring up the String Attribute Editor:

(Continues on next page.)
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7. Key in the KVM Over the NETTM switch permission attribute values. For 
example:

Note: The possible string attributes are the same as for Radius. See the 
table on page 48 for full details.

8. Click OK. When you return to the Attribute Editor page, the iKVM2116-
userProfile entry now reflects the new permissions:

a) Click Apply to save the change and complete the procedure. Jason now 
has the same permissions as user.

b) Repeat the Editing Active Directory Users procedure for any other users 
you wish to add.
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OpenLDAP

OpenLDAP is an Open source LDAP server designed for Unix platforms. A 
Windows version can be downloaded from:

http://download.bergmans.us/openldap/openldap-2.2.29/
openldap-2.2.29-db-4.3.29-openssl-0.9.8a-
win32_Setup.exe.

OpenLDAP Server Installation
After downloading the program, launch the installer, select your language, 
accept the license and choose the target installation directory. The default 
directory is: c:\Program Files\OpenLDAP.

When the Select Components dialog box appears, select install BDB-tools and 
install OpenLDAP-slapd as NT service, as shown in the diagram, below:
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OpenLDAP Server Configuration
The main OpenLDAP configuration file, slapd.conf, has to be customized 
before launching the server. The modifications to the configuration file will do 
the following:

Specify the Unicode data directory. The default is ./ucdata.
Choose the required LDAP schemas. The core schema is mandatory.
Configure the path for the OpenLDAP pid and args start up files. The first 
contains the server pid, the second includes command line arguments.
Choose the database type. The default is bdb (Berkeley DB).
Specify the server suffix. All entries in the directory will have this suffix, 
which represents the root of the directory tree. For example, with suffix 
dc=aten,dc=com, the fully qualified name of all entries in the database 
will end with dc=aten,dc=com.
Define the name of the administrator entry for the server (rootdn), along 
with its password (rootpw). This is the server's super user. The rootdn 
name must match the suffix defined above. (Since all entry names must 
end with the defined suffix, and the rootdn is an entry.)

An example configuration file is provided in the figure, below:
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Starting the OpenLDAP Server
To start the OpenLDAP Server, run slapd (the OpenLDAP Server executable 
file) from the command line. slapd supports a number of command line 
options, the most important option is the d switch that triggers debug 
information. For example, a command of:

slapd -d 256

would start OpenLDAP with a debug level of 256, as shown in the following 
screenshot:

Note: For details about slapd options and their meanings, refer to the 
OpenLDAP documentation.
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Customizing the OpenLDAP Schema
The schema that slapd uses may be extended to support additional syntaxes, 
matching rules, attribute types, and object classes.

In the case of the KL9108 / KL9116, the User Class and the User Profile 
attribute are extended to define a new schema (e.g. kn2116.schema). The 
extended schema file used to authenticate and authorize users logging in to the 
KL9108 / KL9116 is shown in the figure, below:
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LDAP DIT Design and LDIF File

LDAP Data Structure
An LDAP Directory stores information in a tree structure known as the 
Directory Information Tree (DIT). The nodes in the tree are directory entries, 
and each entry contains information in attribute-value form. An example of the 
LDAP directory tree for the KL9108 / KL9116 is shown in the figure, below:

(Continues on next page.)
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DIT Creation
The LDAP Data Interchange Format (LDIF) is used to represent LDAP entries 
in a simple text format (please refer to RFC 2849). The figure below illustrates 
an LDIF file that creates the DIT for the KL9108 / KL9116 directory tree 
(shown in the figure, above).

Note: The example above shows the permissions for a Type 1 Schema. For a 
Type 2 Schema, change the permissions line to su/user. (Where user 
represents the Username of a KL9108 / KL9116 user whose 
permissions reflect the permissions you want steve to have.)

(Continues on next page.)
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Using the New Schema
To use the new schema, do the following:

1. Save the new schema file (e.g., kn2116.schema) in the /OpenLDAP/
schema/ directory.

2. Add the new schema to the slapd.conf file, as shown in the figure, below:

3. Restart the LDAP server.

4. Write the LDIF file and create the database entries in init.ldif with the 
ldapadd command, as shown in the following example:
ldapadd -f init.ldif -x -D "cn=Manager,dc=aten,dc=com" 
-w secret
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Safety Instructions

General
This product is for indoor use only. 
Read all of these instructions. Save them for future reference.
Follow all warnings and instructions marked on the device.
To prevent damage to your installation it is important that all devices are 
properly grounded.
Do not place the device on any unstable surface (cart, stand, table, etc.). If 
the device falls, serious damage will result.
Do not use the device near water.
Do not place the device near, or over, radiators or heat registers.
The device cabinet is provided with slots and openings to allow for 
adequate ventilation. To ensure reliable operation, and to protect against 
overheating, these openings must never be blocked or covered.
The device should never be placed on a soft surface (bed, sofa, rug, etc.) as 
this will block its ventilation openings. Likewise, the device should not be 
placed in a built in enclosure unless adequate ventilation has been provided.
Never spill liquid of any kind on the device.
Unplug the device from the wall outlet before cleaning. Do not use liquid 
or aerosol cleaners. Use a damp cloth for cleaning.
The device should be operated from the type of power source indicated on 
the marking label. If you are not sure of the type of power available, 
consult your dealer or local power company.
The device is designed for IT power distribution systems with 230V 
phase-to-phase voltage.
The device is equipped with a 3-wire grounding type plug. This is a safety 
feature. If you are unable to insert the plug into the outlet, contact your 
electrician to replace your obsolete outlet. Do not attempt to defeat the 
purpose of the grounding-type plug. Always follow your local/national 
wiring codes.
Do not allow anything to rest on the power cord or cables. Route the 
power cord and cables so that they cannot be stepped on or tripped over.
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If an extension cord is used with this device make sure that the total of the 
ampere ratings of all products used on this cord does not exceed the 
extension cord ampere rating. Make sure that the total of all products 
plugged into the wall outlet does not exceed 15 amperes.
To help protect your system from sudden, transient increases and 
decreases in electrical power, use a surge suppressor, line conditioner, or 
uninterruptible power supply (UPS).
Position system cables and power cables carefully; Be sure that nothing 
rests on any cables.
Never push objects of any kind into or through cabinet slots. They may 
touch dangerous voltage points or short out parts resulting in a risk of fire 
or electrical shock.
Do not attempt to service the device yourself. Refer all servicing to 
qualified service personnel.
If the following conditions occur, unplug the device from the wall outlet 
and bring it to qualified service personnel for repair.

The power cord or plug has become damaged or frayed.
Liquid has been spilled into the device.
The device has been exposed to rain or water.
The device has been dropped, or the cabinet has been damaged.
The device exhibits a distinct change in performance, indicating a need 
for service.
The device does not operate normally when the operating instructions 
are followed.

Only adjust those controls that are covered in the operating instructions. 
Improper adjustment of other controls may result in damage that will 
require extensive work by a qualified technician to repair.
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Rack Mounting
Before working on the rack, make sure that the stabilizers are secured to 
the rack, extended to the floor, and that the full weight of the rack rests on 
the floor. Install front and side stabilizers on a single rack or front 
stabilizers for joined multiple racks before working on the rack.
Always load the rack from the bottom up, and load the heaviest item in the 
rack first.
Make sure that the rack is level and stable before extending a device from 
the rack.
Use caution when pressing the device rail release latches and sliding a 
device into or out of a rack; the slide rails can pinch your fingers.
After a device is inserted into the rack, carefully extend the rail into a 
locking position, and then slide the device into the rack.
Do not overload the AC supply branch circuit that provides power to the 
rack. The total rack load should not exceed 80 percent of the branch circuit 
rating.
Ensure that proper airflow is provided to devices in the rack.
Do not step on or stand on any device when servicing other devices in a 
rack.
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Consignes de sécurité 

Général
Ce produit est destiné exclusivement à une utilisation à l’intérieur.
Veuillez lire la totalité de ces instructions. Conservez-les afin de pouvoir 
vous y référer ultérieurement.
Respectez l’ensemble des avertissements et instructions inscrits sur 
l’appareil.
Ne placez jamais l’unité sur une surface instable (chariot, pied, table, etc.). 
Si l’unité venait à tomber, elle serait gravement endommagée.
N’utilisez pas l’unité à proximité de l’eau.
Ne placez pas l’unité à proximité de ou sur des radiateurs ou bouches de 
chaleur.
Le boîtier de l’unité est doté de fentes et d’ouvertures destinées à assurer 
une ventilation adéquate. Pour garantir un fonctionnement fiable et 
protéger l’unité contre les surchauffes, ces ouvertures ne doivent jamais 
être bloquées ou couvertes.
L’unité ne doit jamais être placée sur une surface molle (lit, canapé, tapis, 
etc.) car ses ouvertures de ventilation se trouveraient bloquées. De même, 
l’unité ne doit pas être placée dans un meuble fermé à moins qu'une 
ventilation adaptée ne soit assurée.
Ne renversez jamais de liquides de quelque sorte que ce soit sur l’unité.
Débranchez l’unité de la prise murale avant de la nettoyer. N’utilisez pas 
de produits de nettoyage liquide ou sous forme d’aérosol. Utilisez un 
chiffon humide pour le nettoyage de l’unité.
L’appareil doit être alimenté par le type de source indiqué sur l’étiquette. 
Si vous n’êtes pas sûr du type d’alimentation disponible, consultez votre 
revendeur ou le fournisseur local d’électricité.
Afin de ne pas endommager votre installation, vérifiez que tous les 
périphériques sont correctement mis à la terre.
L’unité est équipée d’une fiche de terre à trois fils. Il s’agit d’une fonction 
de sécurité. Si vous ne parvenez pas à insérer la fiche dans la prise murale, 
contactez votre électricité afin qu’il remplace cette dernière qui doit être 
obsolète. N’essayez pas d’aller à l’encontre de l’objectif de la fiche de 
terre. Respectez toujours les codes de câblage en vigueur dans votre 
région/pays.
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L’équipement doit être installé à proximité de la prise murale et le 
dispositif de déconnexion (prise de courant femelle) doit être facile 
d’accès.
La prise murale doit être installée à proximité de l’équipement et doit être 
facile d’accès.
Veillez à ce que rien ne repose sur le cordon d’alimentation ou les câbles. 
Acheminez le cordon d’alimentation et les câbles de sorte que personne ne 
puisse marcher ou trébucher dessus.
En cas d’utilisation d’une rallonge avec cette unité, assurez-vous que le 
total des ampérages de tous les produits utilisés sur cette rallonge ne 
dépasse pas l’ampérage nominal de cette dernière. Assurez-vous que le 
total des ampérages de tous les produits branchés sur la prise murale ne 
dépasse pas 15 ampères.
Pour contribuer à protéger votre système contre les augmentations et 
diminutions soudaines et transitoires de puissance électrique, utilisez un 
parasurtenseur, un filtre de ligne ou un système d’alimentation sans 
coupure (UPS).
Placez les câbles du système et les câbles d’alimentation avec précaution ; 
veillez à ce que rien ne repose sur aucun des câbles.
Lors du branchement ou du débranchement à des blocs d’alimentation 
permettant la connexion à chaud, veuillez respecter les lignes directrices 
suivantes:
Installez le bloc d’alimentation avant de brancher le câble d’alimentation à 
celui-ci.
Débranchez le câble d’alimentation avant de retirer le bloc d'alimentation.
Si le système présente plusieurs sources d’alimentation, déconnectez le 
système de l'alimentation en débranchant tous les câbles d'alimentation des 
blocs d'alimentation.
N’insérez jamais d’objets de quelque sorte que ce soit dans ou à travers les 
fentes du boîtier. Ils pourraient entrer en contact avec des points de tension 
dangereuse ou court-circuiter des pièces, entraînant ainsi un risque 
d’incendie ou de choc électrique.
N’essayez pas de réparer l’unité vous-même. Confiez toute opération de 
réparation à du personnel qualifié.
Si les conditions suivantes se produisent, débranchez l’unité de la prise 
murale et amenez-la à un technicien qualifié pour la faire réparer:

Le cordon d’alimentation ou la fiche ont été endommagés ou éraillés.
Du liquide a été renversé dans l’unité.
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L’unité a été exposée à la pluie ou à l’eau.
L’unité est tombée ou le boîtier a été endommagé.
Les performances de l’unité sont visiblement altérées, ce qui indique la 
nécessité d’une réparation.
L’unité ne fonctionne pas normalement bien que les instructions 
d’utilisation soient respectées.

N’utilisez que les commandes qui sont abordées dans le mode d’emploi. 
Le réglage incorrect d’autres commandes peut être à l’origine de 
dommages qui nécessiteront beaucoup de travail pour qu’un technicien 
qualifié puisse réparer l’unité.
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Montage sur bâti
Avant de travailler sur le bâti, assurez-vous que les stabilisateurs sont bien 
fixées sur le bâti, qu’ils sont étendus au sol et que tout le poids du bâti 
repose sur le sol. Installez les stabilisateurs avant et latéraux sur un même 
bâti ou bien les stabilisateurs avant si plusieurs bâtis sont réunis, avant de 
travailler sur le bâti.
Chargez toujours le bâti de bas en haut et chargez l’élément le plus lourd 
en premier.
Assurez-vous que le bâti est à niveau et qu’il est stable avant de sortir une 
unité du bâti.
Agissez avec précaution lorsque vous appuyez sur les loquets de libération 
du rail d’unité et lorsque vous faites coulisser une unité dans et hors d’un 
bâti ; vous pourriez vous pincer les doigts dans les rails.
Une fois qu’une unité a été insérée dans le bâti, étendez avec précaution le 
rail dans une position de verrouillage puis faites glisser l’unité dans le bâti.
Ne surchargez pas le circuit de l’alimentation CA qui alimente le bâti. La 
charge totale du bâti ne doit pas dépasser 80 % de la capacité du circuit.
Assurez-vous que tous les équipements utilisés sur le bâti, y-compris les 
multiprises et autres connecteurs électriques, sont correctement mis à la 
terre.
Assurez-vous que les unités présentes dans le bâti bénéficie d’une 
circulation d’air suffisante.
Assurez-vous que la température ambiante de fonctionnement de 
l’environnement du bâti ne dépasse pas la température ambiante maximale 
spécifiée pour l’équipement par le fabricant.
Ne marchez sur aucun appareil lors de la maintenance d’autres appareils 
d’un bâti.
Attention: Glisser / rail (LCD KVM) monté l'équipement ne doit pas être 
utilisé comme une étagère ou un espace de travail.
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Technical Support

Technical support is available both by email and online (with a browser over 
the web):
International

For online technical support – including troubleshooting, documentation, 
and software updates: http://eservice.aten.com
For telephone support, see Telephone Support, page iii

North America

When you contact us, please have the following information ready beforehand:
Product model number, serial number, and date of purchase.
Your computer configuration, including operating system, revision level, 
expansion cards, and software.
Any error messages displayed at the time the error occurred.
The sequence of operations that led up to the error.
Any other information you feel may be of help.

Email Support support@aten-usa.com

Online 
Technical 
Support

Troubleshooting
Documentation
Software Updates

http://www.aten-usa.com/support

Telephone Support 1-888-999-ATEN ext 4988
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Specifications

(Continues on next page.)

Function KL9108 KL9116

Computer 
Connections

Direct 8 16

Max. 64 (via Cascade) 128 (via Cascade)

Console 
Connections

Local 1

Remote 1

Port Selection OSD, Hotkey, Pushbutton

Connectors Console 
Port

Keyboard 1 x 6-pin Mini-DIN Female (Purple)

Video 1 x HDB-15 Female (Blue)

Mouse 1 x 6-pin Mini-DIN Female (Green)

KVM Port 8 x SPHD-15 Female 
(Yellow)

16 x SPHD-15 Female 
(Yellow)

Power 1 x 3 Prong AC Socket

External Mouse 1 x 6-pin Mini-DIN Female (Green)

LAN 1 x RJ-45 Female (Black)

PON 1 x DB-9 Male (Black)

Switches Reset 1 x Semi-recessed Pushbutton

Power 1 x Rocker

Port Selection 2 x Pushbutton

LCD Power 1 x Pushbutton

LCM Adjustment 4 x Pushbutton

LEDs On Line 8 (Green) 16 (Green)

Selected 8 (Orange) 16 (Orange)

Power 1 (Blue)

Num Lock 1 (Green)

Caps Lock 1 (Green)

Scroll Lock 1 (Green)

Link 1 (Green)

10/100 Mbps 1 (Orange/Green)
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OSD Factory Default Settings

The factory default settings are as follows:

Function KL9108 KL9116

Emulation Keyboard/Mouse PS/2

Video 17" LCD 1280 x 1024 @ 75 Hz; DDC2B

Remote 1600 x 1200 @ 60 Hz; DDC2B

Scan Interval 1–255 Seconds

I/P Rating 100–240V AC, 50/60 Hz, 1A

Power Consumption 120V/31W; 230V/39W

Environment Operating Temp. 0–40° C

Storage Temp. -20–60° C

Humidity 0–80% RH, Non-condensing

Physical 
Properties

Housing Metal

Weight 17.10 kg 17.30 kg

Dimensions 
(L x W x H)

70.50 x 48.20 x 4.40 cm 
(19"/1U)

70.50 x 48.20 x 4.40 cm 
(19"/1U)

Setting Default

OSD Hotkey [Scroll Lock] [Scroll Lock]

Port ID Display Port Number + Name

Port ID Display Duration 5 Seconds

Scan / Skip Mode All

Scan Duration 10 Seconds

Screen Blanker 0 Minutes (disabled)

Beeper On

Accessible Ports F (Full) For all Users on all Ports
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Trusted Certificates

Overview
When you try to login to the KL9108 / KL9116 from your Web browser, a 
Security Alert message appears to inform you that the device’s certificate is not 
trusted, and asks if you want to proceed.

The certificate can be trusted, but the alert is triggered because the certificate’s 
name is not found on Microsoft’s list of Trusted Authorities. You have two 
options: 1) you can ignore the warning and click Yes to go on; or 2) you can 
install the certificate and have it be recognized as trusted.

If you are working on a computer at another location, accept the certificate 
for just this session by clicking Yes.
If you are working at your own computer, install the certificate on your 
computer (see below for details). After the certificate is installed, it will be 
recognized as trusted.
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Installing the Certificate
To install the certificate:

1. In the Security Alert dialog box, click View Certificate. The Certificate 
dialog box appears.

Note: There is a red and white X logo over the certificate to indicate that it is 
not trusted.

2. Click Install Certificate.

3. Follow the Installation Wizard to complete the installation. Unless you 
have a specific reason to choose otherwise, accept the default options. The 
Wizard presents a caution screen:

4. Click Yes.
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5. Click Finish to complete the installation.

6. Click OK to close the dialog box.

Certificate Trusted
The certificate is now trusted:

When you click View Certificate, you can see that the red and white X logo is 
no longer present – further indication that the certificate is trusted.
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Troubleshooting

Overview
Operation problems can be due to a variety of causes. The first step in solving 
them is to make sure that all cables are securely attached and seated completely 
in their sockets.

In addition, updating the product’s firmware may solve problems that have 
been discovered and resolved since the prior version was released. If your 
product is not running the latest firmware version, we strongly recommend that 
you upgrade. See Upgrading the Firmware, page 61, for upgrade details.

Administration

Problem Resolution

After upgrading firmware, 
the KL9108 / KL9116 still 
appears to be using the old 
firmware version.

Delete all temporary Internet files and cookies, close the 
Web browser, and then open a new instance of the Web 
browser.

After making changes and 
checking Reset on exit and 
then logging out, the 
KL9108 / KL9116 doesn’t 
reset after I exit.

Upgrade your browser to IE 6.0.2800.1106 or higher.

After making changes and 
checking Reset on exit, 
when I log back in the 
calendar changes to an 
incorrect (much earlier) 
date.

Log in from a remote console to automatically recover 
the correct date.
If you log in from the local console, go to the 
Administration page and reset the calendar to the correct 
date (see page 41 and page 59).
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General Operation
Problem Resolution

Erratic operation Press and hold the Reset button (see page 9) for at least 
three seconds.

Mouse and/or keyboard not 
responding

Unplug the cable(s) from the console port(s), and then 
plug it back in again.

Sudden loss of network 
connection

Close your KL9108 / KL9116 connection. Wait 
approximately 30 seconds, and then log in again.

When logging in from a 
browser, the following 
message appears: 404 
Object Not Found.

Make sure to include the forward slash and correct login 
string when you specify the KL9108 / KL9116's IP 
address. (See Default Webpage Name, page 54.)

Two pointers appear when I 
login from a remote 
computer.

You can shrink the non-functioning pointer so that it is 
almost invisible. See Toggle mouse display, page 77, for 
details.

The OSD display is 
intermittent when accessing 
a computer for which the 
display refresh rate is set to 
56Hz.

Press [F6] to blank the background when using the OSD.

I can’t set the computers’ 
screen resolutions higher 
than 1280 x 1024, even 
though the KL9108 / 
KL9116 supports 1600 x 
1200 for remote computers.

If you wish to set the screen resolutions of the connected 
computers to something higher than 1280 x 1024, see 
Screen Resolutions Higher than 1280 x 1024, page 156.

When I switch to one of the 
computers on my 
installation, the LCD 
monitor screen goes blank. 
All I see is a black screen.

To resolve the problem, connect an external KVM 
console (with a monitor capable of displaying the 
problem computer’s screen resolution) to the KL9108 / 
KL9116’s external console ports. Use the external 
console to access the problem computer and reduce its 
resolution to 1280 x 1024.
Note: Although the LCD monitor only supports video 
resolutions of up to 1280 x 1024, the KL9108 / KL9116, 
itself can support video resolutions up to 1600 x 1200 @ 
60 Hz. If you wish to set the screen resolutions of the 
connected computers to something higher than 1280 x 
1024, see Screen Resolutions Higher than 1280 x 1024, 
page 156 for details.

When viewing a computer 
with a high screen 
resolution from a remote 
computer, I can’t see the 
entire desktop.

Try to move the pointer up and down, and side to side to 
expose the parts of the desktop that you can’t see. If this 
doesn’t work, toggling the mouse display will allow you to 
use the computer’s own pointer to view the rest of the 
desktop. See Toggle mouse display, page 77.
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The Java Client
For mouse synchronization problems, see The Message Board Button Bar, 
page 99, and Additional Mouse Synchronization Procedures, page 158. For 
connection and operation problems, see the table below:

The Log Server

Problem Resolution

Java Client won't connect to 
the KL9108 / KL9116.

1. Java 2 JRE 1.4.2 or higher must be installed on your 
computer.

2. Make sure to include the forward slash and login 
string (see Default Webpage Name, page 54) when 
you specify the KL9108 / KL9116's IP address.

3. Close the Java Client, reopen it, and try again.

Pressing the Windows 
Menu key has no effect.

Java doesn't support the Windows Menu key.

Java Client performance 
deteriorates.

Exit the program and start again.

National language 
characters do not appear.

If the local keyboard is set to a non-English layout, you 
must set the remote computer's keyboard layout to 
English.

IP and MAC address filters 
do not work with the Java 
Client.

IP and MAC address filters only work with the Windows 
Client. We recommend using the Default Web page 
name (see page 53) as a means to enhance the overall 
security of the KVM switch.

Problem Resolution

The Log Server program 
does not run.

The Log Server requires a file provided by Microsoft in 
order to access the database.
This file is automatically installed with Windows ME, 
2000, and XP.
For Windows 98 and NT you will have to go to the 
Microsoft download site:
http://www.microsoft.com/data/download.htm to retrieve 
the file:

MDAC 2.7 RTM - Refresh (2.70.9001.0)
Since this driver is used in Windows Office Suite, an 
alternate method of obtaining it is to install Windows 
Office Suite. Once the driver file or Suite has been 
installed, the Log Server will run.
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Panel Array Mode

The Windows Client

Problem Resolution

Low resolution video in 
Panel Array Mode.

Increase the number of panels that are displayed.

When multiple remote users 
are logged in concurrently, 
some of them only receive a 
partial image.

The first user to invoke Panel Array Mode should set it to 
display at least 4 panels.

Problem Resolution

The Windows Client won't 
connect to the KL9108 / 
KL9116.

DirectX 7.0 or higher must be installed on the remote 
computer.

The remote computer’s 
pointer is out of sync.

1. Use the AutoSync feature (see Video Adjustment, 
page 78), to sync the local and remote monitors.

2. If that doesn't resolve the problem, use the Adjust 
Mouse feature (see Adjust mouse, page 77) to bring 
them back in sync.

3. If the two methods described above fail to resolve the 
problem, use the Toggle Mouse Display function (see 
page 77).

4. See Additional Mouse Synchronization Procedures, 
page 158.

Part of the remote window 
is off my monitor.

1. If Keep Screen Size (see page 72) is not enabled, use 
the AutoSync feature (see Video Adjustment, 
page 78) to synchronize the local and remote moni-
tors.

2. If Keep Screen Size is enabled, you can scroll to the 
areas that are off the screen. See the note on page 72 
for details.

The remote computer’s 
display is rotated 90 
degrees.

Enable Keep Screen Size (see page 72).

I cannot run Net Meeting 
when the Windows Client is 
running.

Enable Keep Screen Size (see page 72).

When I log in, the browser 
generates a CA Root 
certificate is not trusted, or 
a Certificate Error 
response.

The certificate’s name is not found on Microsoft’s list of 
Trusted Authorities. However, the certificate can be 
trusted. See Trusted Certificates, page 149, for details.
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Sun Systems

* These solutions work for most common Sun VGA cards. If using them fails 
to resolve the problem, consult the Sun VGA card's manual.

Screen Resolutions Higher than 1280 x 1024
The maximum screen resolution of the KL9108 / KL9116’s integrated LCD 
monitor is 1280 x 1024. In order to protect it from being damaged by 
resolutions that are beyond its display capability, we recommend that the 
screen resolutions of the connected computers be set to 1280 x 1024 or lower.

If you wish to display screen resolutions higher than 1280 x 1024, follow the 
procedure described below to change the computers’ screen resolutions and 
safeguard the KL9108 / KL9116’s LCD monitor:

Problem Resolution

Video display problems with 
HDB-15 interface systems 
(e.g. Sun Blade 1000 
servers).

The display resolution should be set to 1024 x 768 @ 
60Hz.
Under Text Mode:
1. Enter the ok prompt and issue the following firmware 

commands:

setenv output-device screen:r1024x768x60
reset-all

Under XWindow:
1. Open a console and issue the following command:

m64config -res 1024x768x60

2. Log out.
3. Log in.

Video display problems with 
13W3 interface systems 
(e.g. Sun Ultra servers).*

The display resolution should be set to 1024 x 768 @ 
60Hz.
Under Text Mode:
1. Enter the ok prompt and issue the following firmware 

commands:

setenv output-device screen:r1024x768x60
reset-all

Under XWindow:
1. Open a console and issue the following command:

ffbconfig -res 1024x768x60

2. Log out.
3. Log in.
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Note: We strongly recommend that you close the KL9108 / KL9116 LCD 
console before continuing (see Closing the Console, page 25.) Using 
the LCD monitor to view computers that are set to resolutions that 
exceed its maximum capability can damage it and shorten its life span.

To access computers from the local console when the integrated console 
is closed, simply connect an external KVM console with a monitor that 
supports 1600 x 1200 @ 60 Hz to the KL9108 / KL9116’s external 
console ports.

1. From a remote computer, log into the KL9108 / KL9116 and access the 
computer whose screen resolution you wish to change.

2. Open the computer’s Control Panel and double-click Display. The 
Display Properties dialog box appears.

3. Click the Settings tab, and then click Advanced.

4. In the dialog box that appears, click the Monitor tab.

5. Under Monitor settings, click to clear the Hide modes that this monitor 
cannot display check box.

6. Click Apply.

7. Click the Adapter tab, and then click List All Modes. The List All Modes 
dialog box appears.

8. Under List of valid modes, select the display mode that you want the 
computer to use.

Note: The maximum screen resolution and refresh rate that the KL9108 / 
KL9116 supports for remote computers is 1600 x 1200@60 Hz.

9. Click OK, and then click Apply. The display mode changes to the one you 
selected.

10. If the Monitor Settings dialog box appears requesting you to confirm the 
settings change, click Yes.

11. After the Monitor Settings dialog box closes, click OK.

12. In the Display Properties dialog box, click OK.

This completes the procedure. Repeat these steps for any other computer whose 
screen resolution you wish to change.
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Additional Mouse Synchronization Procedures
If the mouse synchronization procedures mentioned in the manual fail to 
resolve mouse pointer problems for particular computers, try the following:

Note: 1. These procedures are to be performed on the computers attached to 
the KL9108 / KL9116's ports - not on the computer you are using to 
access the KL9108 / KL9116.

2. In order for the local and remote mice to synchronize, you must use 
the generic mouse driver supplied with the Windows operating 
system. If you have a third party driver installed - such as one 
supplied by the mouse manufacturer - you must remove it.

Windows:
1. Windows 2000:

a) Open the Mouse Properties dialog box (Control Panel → Mouse → 
Mouse Properties)

b) Click the Motion tab

c) Set the mouse speed to the middle position (6 units in from the left)

d) Set the mouse acceleration to None
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2. Windows XP / Windows Server 2003:

a) Open the Mouse Properties dialog box (Control Panel → Mouse)

b) Click the Pointer Options tab

c) Set the mouse speed to the middle position (6 units in from the left)

d) Disable Enhance Pointer Precision

3. Windows ME:
Set the mouse speed to the middle position; disable mouse acceleration 
(click Advanced to get the dialog box for this).

4. Windows NT / Windows 98 / Windows 95:
Set the mouse speed to the slowest position.

Sun / Linux:

Open a terminal session and issue the following command:
Sun: xset m 1

Linux: xset m 0
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Administrator Login Failure

If you are unable to perform an Administrator login (because the Username and 
Password information has become corrupted, or you have forgotten it, for 
example), there is a procedure you can use to clear the login information.

Note: Performing this procedure also returns all settings to their defaults.

To clear the login information (and return all settings to their defaults), do the 
following:

1. Power off the KL9108 / KL9116 and remove the power cord from the 
power socket.

2. Remove the cover from the KL9108 / KL9116.

3. Using a jumper cap, short the jumper labeled J18 on the mainboard.

4. Replace the power cord and power on the KL9108 / KL9116.

5. When the front panel LEDs flash, power off the KL9108 / KL9116 and 
remove the power cord from the power socket again.

6. Remove the jumper cap from the jumper.

7. Replace the cover on the switch. Replace the power cord and power on the 
KVM switch.

8. After powering on the unit, you can use the default Username and 
Password (see page 31) to log in.
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Optional Rack Mounting

For convenience and flexibility, three optional rack mounting kits are available 
as shown in the following table:

To install the long bracket standard rack mount kit, simply replace the short L 
brackets on the standard rack mount kit with the long ones, and mount the 
switch according to the instructions given for Standard Rack Mounting, 
page 14.

While it takes two people to perform a standard installation, with an Easy-
Installation, kit, one person can mount the switch. To install the Easy-
Installation kit, do the following:

1. Remove the standard L brackets and the side mounting brackets from both 
sides of the switch.

KVM Model Bracket Type Size (cm)

KL9108 / KL9116 Standard Installation – Long 68.0–105.0

Easy Installation – Short 57.0–70.0

Easy Installation – Long 68.0–105.0

Phillips head hex
M4L4-6pcs   
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2. Attach the left and right easy-installation mounting rails to the inside of 
the rack. The flange that supports the switch will be to the inside.

a) Screw the front flanges to the rack first.

b) Slide the bars with the rear flanges toward the rack until the flanges 
make contact with the rack, then screw the rear flanges to the rack.

Rear Attachment
Sliding Bracket

Support
Flange

Slide Bar

Rear Flange

Front Flange

LEFT
RAIL

RIGHT
RAIL
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3. Slide the switch onto the support flanges. Use the screws supplied with 
this package to loosely attach the front of the switch to the front of the rack 
(only tighten the screws part way).

4. Slide the rear attachment sliding brackets along the slide bars until they 
contact the rear of the switch, then use the screws supplied with this 
package to attach the bars to the rear of the switch (tighten the screws all 
the way).

Phillips I head
M4L6                   

Phillips I head
M4L6                   
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5. Slide the switch open and closed a couple of times to be sure that it is 
properly aligned and operating smoothly. (See Opening the Console, 
page 21 for opening and closing procedures.)

6. After determining that the switch is properly lined up and operating 
correctly, finish up by fully tightening down the partially tightened front 
attachment screws inserted in Step 3.

Dedicated Invocation Keys

Two dedicated keys (below) are provided on the keyboard module to make it 
easy to invoke the OSD and the OSD Toolbar:

Note: These keys are toggles. Press once to invoke the feature, press again to 
exit.

The KVM OSD Key invokes the OSD See The Local Console, page 31, 
for details.
The KVM Hotkey Key opens the OSD Toolbar, which allows you to 
control the KL9108 / KL9116 from within the captured port. See The OSD 
Toolbar, page 85, for details.
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About SPHD Connectors

Supported KVM Switches

The following is a list of supported KVM switches that can be cascaded from 
the KL9108 / KL9116.

KH88
KH98
CS88A
CS138A
CS9134
CS9138

Note: The KL9108 / KL9116 OSD port list does not display ports on cascaded 
KVM switches. After accessing a cascaded switch, invoke its OSD to 
manage its ports.

This product uses SPHD connectors for its KVM and/or 
Console ports. We have specifically modified the shape of these 
connectors so that only KVM cables that we have designed to 
work with this product can be connected.
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Limited Warranty

ATEN warrants this product against defects in material or workmanship for a period of one (1) year 
from the date of purchase. If this product proves to be defective, contact ATEN's support 
department for repair or replacement of your unit. ATEN will not issue a refund. Return requests 
can not be processed without the original proof of purchase.

When returning the product, you must ship the product in its original packaging or packaging that 
gives an equal degree of protection. Include your proof of purchase in the packaging and the RMA 
number clearly marked on the outside of the package.

This warranty becomes invalid if the factory-supplied serial number has been removed or altered 
on the product.

This warranty does not cover cosmetic damage or damage due to acts of God, accident, misuse, 
abuse, negligence or modification of any part of the product. This warranty does not cover damage 
due to improper operation or maintenance, connection to improper equipment, or attempted repair 
by anyone other than ATEN. This warranty does not cover products sold AS IS or WITH FAULTS.

IN NO EVENT SHALL ATEN'S LIABILITY EXCEED THE PRICE PAID FOR THE 
PRODUCT. FURTHER, ATEN SHALL NOT BE RESPONSIBLE FOR DIRECT, INDIRECT, 
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES RESULTING FROM THE USE 
OF THE PRODUCT, ITS ACCOMPANYING SOFTWARE, OR ITS DOCUMENTATION. 
ATEN SHALL NOT IN ANY WAY BE RESPONSIBLE FOR, WITHOUT LIMITATION, LOSS 
OF DATA, LOSS OF PROFITS, DOWNTIME, GOODWILL, DAMAGE OR REPLACEMENT 
OF EQUIPMENT OR PROPERTY, AND ANY EXPENSES FROM RECOVERY, 
PROGRAMMING, AND REPRODUCTION OF ANY PROGRAM OR DATA.

ATEN makes no warranty or representation, expressed, implied, or statutory with respect to its 
products, contents or use of this documentation and all accompanying software, and specifically 
disclaims its quality, performance, merchantability, or fitness for any particular purpose.

ATEN reserves the right to revise or update its product, software or documentation without 
obligation to notify any individual or entity of such revisions, or update.

For details about extended warranties, please contact one of our dedicated value added resellers.
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